Text, graphics, and multimedia materials employed in learning a computer-based procedural task

Kari Christine Carlson Coffindaffer
West Virginia University

Follow this and additional works at: https://researchrepository.wvu.edu/etd

Recommended Citation
Coffindaffer, Kari Christine Carlson, "Text, graphics, and multimedia materials employed in learning a computer-based procedural task" (2010). Graduate Theses, Dissertations, and Problem Reports. 2967. https://researchrepository.wvu.edu/etd/2967

This Dissertation is protected by copyright and/or related rights. It has been brought to you by the The Research Repository @ WVU with permission from the rights-holder(s). You are free to use this Dissertation in any way that is permitted by the copyright and related rights legislation that applies to your use. For other uses you must obtain permission from the rights-holder(s) directly, unless additional rights are indicated by a Creative Commons license in the record and/or on the work itself. This Dissertation has been accepted for inclusion in WVU Graduate Theses, Dissertations, and Problem Reports collection by an authorized administrator of The Research Repository @ WVU. For more information, please contact researchrepository@mail.wvu.edu.
TEXT, GRAPHICS, AND MULTIMEDIA MATERIALS EMPLOYED IN LEARNING A COMPUTER-
BASED PROCEDURAL TASK

Kari Christine Carlson Coffindaffer

DISSERTATION

Submitted to the College of Human Resources and Education
at
West Virginia University
In Partial Fulfillment of the Requirements for the Degree of
Doctor of Education
in
Educational Psychology
Department of Technology, Learning, and Culture
Morgantown, West Virginia
2010

Doctoral Committee: Richard T. Walls, PhD; Chair
Daniel E. Hursh, PhD
Jaci Webb-Dempsey, PhD
Joy Faini Saab, EdD
James Held, MFA

Keywords: Multimedia Learning, Visual Design, Multimedia Design, Procedural Learning

Copyright 2010, Kari Christine Carlson Coffindaffer. All Rights Reserved
ABSTRACT

Text, Graphics, and Multimedia Materials Employed In Learning
A Computer-Based Procedural Task

Kari Christine Carlson Coffindaffer

The present research study investigated the interaction of graphic design students with different forms of software training materials. Four versions of the procedural task instructions were developed (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video and (D) Onscreen Narrated Video for four computer tasks. Two research questions guided the study: Research Question 1: Are there any significant differences in student learning of a computer-based procedural task due to the format of the training materials? Research Question 2: Do individual differences in prior knowledge and spatial abilities make a significant difference in student learning? This study included quantitative research methods. The population for the study consisted of sophomore and junior graphics students enrolled in the Computer Applications in Graphics (GRAPHICS 1150) course in the Department of Graphics Technology at a Fairmont State University and Pierpont Community and Technical College during the 2009 spring semester. One section had 8 participants and the other 11 (N=19). The six instruments used to collect data for this study were a Prior Knowledge pre-test, the MRT (a Mental Rotations Test), and 4 counterbalanced graphics image-manipulation tasks. The findings indicate that high spatial ability and high prior knowledge positively affected student’s scores on the graphics image-manipulation tasks and that Training Condition B (Modified Text with Integrated Still Images) was a positive contributor to test scores on the counterbalanced image manipulation tasks. The participants experienced shorter task completion times for any task trained with the Modified Text with Integrated Still Images materials.
ACKNOWLEDGEMENTS

Without the love and support of family, this dissertation would have never come to fruition. I want to thank my loving husband, Mark Coffindaffer for his unfailing optimism, and self-sufficiency. I want to thank my daughter, Carissa for having patience with me during this enduring process, and who proudly tells her Kindergarten friends "My Mom’s going to be a Doctor, but not the kind that helps people". I also want to express my gratitude to my mother, Dorothy Carlson. She is the best day care provider I have ever known, and I am so grateful she agreed to come out of retirement to care for and entertain Carissa while I worked late into the night on many occasions.

Thanks also go to many friends and colleagues who provided mentoring and support to me throughout this process, particularly, Kim Murphy, Melissa Abbott, Joe Reisen, Sue Goodwin, and Gene Turchin for sharing their coffee, chocolate, stats manuals, good humor, and unshakable encouragement in the final stretch. You have no idea how instrumental you were to the completion of this project.

My committee deserves a special thank you for their support during this long, long process. You began this journey as my instructors, became my mentors, and will remain my dear friends. Much appreciation and admiration goes to Dr. Richard Walls who served as my chair and supportive voice during this exhausting process. Thank you Dick, for believing in me, even on days when my belief in myself waxed and waned.
TABLE OF CONTENTS

ABSTRACT..............................................................................................................................................ii
ACKNOWLEDGEMENTS.........................................................................................................................iii
TABLE OF CONTENTS..........................................................................................................................iv
LIST OF FIGURES.....................................................................................................................................xi
LIST OF TABLES......................................................................................................................................xiii
CHAPTER 1 ......................................................................................................................................................1
RESEARCH QUESTIONS AND LITERATURE REVIEW .......................................................................1
INTRODUCTION..........................................................................................................................................1
What is Multimedia?...............................................................................................................................1
What is Multimedia Learning?................................................................................................................2
How is Multimedia Learning Used in a Graphics Curriculum? .........................................................3
RESEARCH QUESTIONS .........................................................................................................................5
Research Question 1 ..............................................................................................................................6
Research Question 2 ..............................................................................................................................7
LITERATURE REVIEW ............................................................................................................................8
Mayer’s Multimedia Learning Theory .................................................................................................8
The Multimedia Principle .....................................................................................................................11
The Spatial Contiguity Principle .........................................................................................................11
The Temporal Contiguity Principle .....................................................................................................12
The Coherence Principle .....................................................................................................................12
The Modality Principle ................................................................. 13
The Redundancy Principle ........................................................... 13
The Individual Differences Principle ........................................... 13
Sweller’s Cognitive Load Theory .................................................. 15
Intrinsic Cognitive Load ............................................................. 15
Extrinsic Cognitive Load ............................................................. 16
Germane Cognitive Load ............................................................ 16
A Split Attention Effect ............................................................... 16
The Redundancy Effect ............................................................... 17
The Modality Effect .................................................................... 17
Lyon’s and Clark’s Guidelines for Training Materials .................... 18
Demonstration Guidelines ............................................................ 19
Complex Procedures ................................................................... 21
Warnings ..................................................................................... 22
On-Screen Contiguous Text .......................................................... 23
Principles of Graphic Design ....................................................... 25
Balance ...................................................................................... 25
Proportion .................................................................................. 27
Sequence .................................................................................... 29
Emphasis ..................................................................................... 31
Unity ........................................................................................... 32
Design Considerations for Typography and Text ............................. 32
CHAPTER 2

METHOD

Participants
Research Design
Instructional Materials
Procedure
Participants
Room Set-up
Workstation Set Up
Headsets
Introduction to the Study
Helpers
Screen Recording Software Training
Participant Folders
Data Collection
The Mental Rotation Test (MRT)
Prior Knowledge
The Tasks
Time to Complete
CHAPTER THREE ........................................................................................................... 72

RESULTS ...................................................................................................................... 72

Purpose ....................................................................................................................... 72

Descriptive Data ......................................................................................................... 73

Time to Complete ...................................................................................................... 74

Percent Correct .......................................................................................................... 77

Errors .......................................................................................................................... 78

Spatial Ability ............................................................................................................. 81

Can Do ........................................................................................................................ 82

Research Question 1: ............................................................................................... 83

A vs. B vs. C vs. D performance on Percent Correct scores ..................................... 83

A vs. B vs. C vs. D on Error Counts ......................................................................... 84

A vs. B vs. C vs. D on Time To Complete scores ...................................................... 85

A vs. B vs. C vs. D on Performance of Completing Tasks ....................................... 86

Research Question 2: ............................................................................................... 88

Can Do vs. Prior Knowledge ..................................................................................... 88
Can Do vs. Spatial Ability................................................................. 90
Can Do vs. Time to Complete.......................................................... 100

CHAPTER FOUR.............................................................................. 102

DISCUSSION................................................................................. 102

What is Multimedia?................................................................. 102
What is Multimedia Learning?.................................................. 102
How is Multimedia Learning Used in a Graphics Curriculum? ......... 103
Discussion of Dependent Variables .............................................. 104
Time to Complete. ....................................................................... 104
Correct Responses. ..................................................................... 106
Errors.......................................................................................... 107
Can Do........................................................................................ 107
Discussion of Research Questions .............................................. 109
Research Question 1..................................................................... 109
Research Question 2..................................................................... 109
Recommendations....................................................................... 109
Limitations of Current Study...................................................... 111
Internal and External Validity Issues and Limitations..................... 111
Measurement Issues................................................................... 112
Significance of the Investigation.................................................. 113

REFERENCES............................................................................... 117
APPENDICES ......................................................................................................................... 126

Appendix A ......................................................................................................................... 126
Instructor’s Permission to Conduct Research in Class ......................................................... 126

Appendix B ......................................................................................................................... 128
West Virginia University IRB Approval and Fairmont State University / Pierpont Community and Technical College IRB Approval ................................................................. 128

Appendix C .......................................................................................................................... 133
Participant Recruitment Script .......................................................................................... 133

Appendix D .......................................................................................................................... 135
Voluntary Consent Form ...................................................................................................... 135

Appendix E .......................................................................................................................... 140
Helper Training Sheet .......................................................................................................... 140

Appendix F .......................................................................................................................... 142
Mental Rotations Test Booklet ........................................................................................... 142

Appendix G .......................................................................................................................... 148
Prior Knowledge Test Booklet ............................................................................................ 148

Appendix H .......................................................................................................................... 153
Testing Materials for Task 1 (A, B, C, D) ....................................................................... 153

Appendix I .......................................................................................................................... 167
Testing Materials for Task 2 (A, B, C, D) ....................................................................... 167

Appendix J .......................................................................................................................... 182
Testing Materials for Task 3 (A, B, C, D) ....................................................................... 182
<table>
<thead>
<tr>
<th>Appendix</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix K</td>
<td>Testing Materials for Task 4 (A, B, C, D)</td>
<td>200</td>
</tr>
<tr>
<td>Appendix L</td>
<td>Inter-rater Reliability Training Materials</td>
<td>217</td>
</tr>
<tr>
<td>Appendix M</td>
<td>Task Scoring Rubric</td>
<td>223</td>
</tr>
<tr>
<td>Appendix N</td>
<td>Prior Knowledge Pretest Answer Key</td>
<td>243</td>
</tr>
<tr>
<td>Appendix O</td>
<td>Prior Knowledge Pretest Validity Instrument</td>
<td>248</td>
</tr>
</tbody>
</table>
LIST OF FIGURES

Figure 1.  Computer interface at Step 1................................................................. 20
Figure 2.  Computer interface at Step 2................................................................. 20
Figure 3.  Arrows used to direct attention in visuals............................................. 21
Figure 4.  Using a moving cursor.......................................................................... 22
Figure 5.  Warnings are displayed prominently and contextually......................... 23
Figure 6.  Prominently displayed onscreen video replay button............................ 24
Figure 7.  Example of Bilateral Symmetry.............................................................. 25
Figure 8.  Asymmetrical Balance and Optical Weight........................................... 26
Figure 9.  Proportions of the Golden Mean.......................................................... 27
Figure 10. Proportions of the Rule of Thirds.......................................................... 28
Figure 11. Title placement above the mathematical center of a page....................... 29
Figure 12. “Z” Eye Tracking pattern...................................................................... 30
Figure 13. Using color and size for emphasis....................................................... 31
Figure 14. Using color harmony for overall unity.................................................... 32
Figure 15. 40% Text layout compared to typical textbook page............................ 34
Figure 16. European page sizes based on the Golden Ratio................................... 35
Figure 17. 2.5 Alphabet length line of text in three common fonts....................... 36
Figure 18. Text set in 12-point type and in 14-point type...................................... 37
Figure 19. Suggested san-serif fonts...................................................................... 37
Figure 20. Example of a Principle of Graphics Design Page Analysis..................... 39
Figure 21. Cover page and Page 2 of the Task 1A Booklet. (Adobe Creative Team, 2007)

Reprinted by permission of Pearson Education, Inc. .................................................. 44

Figure 22. Page 3 and 4 of the Task 1A Booklet. (Adobe Creative Team, 2007) Reprinted by
permission of Pearson Education, Inc. ................................................................. 45

Figure 23. Cover page and Page 2 of the Task 1B Booklet. (Adobe Creative Team, 2007)

Reprinted by permission of Pearson Education, Inc. .................................................. 47

Figure 24. Page 3 and 4 of the Task 1B Booklet ....................................................... 48

Figure 25. Cover page and Page 2 of the Task 1C Booklet ....................................... 49

Figure 26. Screenshot of the Task 1C Training Video and Page 3 of the Task 1C Booklet ....50

Figure 27. Cover page and Page 2 of the Task 1D Booklet. ........................................ 51

Figure 28. Screenshot of the Task 1D Training Video and Page 3 of the Task 1D Booklet.

(Adobe Creative Team, 2007) Reprinted by permission of Pearson Education, Inc........ 52

Figure 29. Cover page and Page 2 of the MRT (Mental Rotation Test) Booklet .............. 53

Figure 30. Page 3 and Page 4 of the MRT (Mental Rotation Test) Booklet .................... 53

Figure 31. Page 5 of the MRT (Mental Rotation Test) Booklet ..................................... 54

Figure 32. Cover page and Page 2 of the Pretest Booklet. ......................................... 55

Figure 33. Page 3 and 4 of the Pretest Booklet .......................................................... 55

Figure 34. Sample Coding Rubric. ............................................................................. 66

Figure 35. Time to Complete Scores. ........................................................................... 105
LIST OF TABLES

Table 1 Possible Combinations of Delivery Materials and Presentation Mode .......................... 10
Table 2 Research Design, 2 by 2 by 4 Mixed Model with Three Independent Variables (IV) and
Four Dependent Variables (DV) ........................................................................................................ 42
Table 3 Counterbalanced Four Tasks with Four Conditions ......................................................... 43
Table 4 Participant Number at Workstations ................................................................................... 57
Table 5 Materials Schedule for Computer Workstations .................................................................. 58
Table 6 Duration of Training Videos ................................................................................................ 63
Table 7 Content Pairing of Prior Knowledge Pretest and the four Tasks ........................................ 69
Table 8 Descriptive Statistics for Time to Complete (DV1) as a continuous dependent variable
for Instructional Materials Conditions A, B, C, and D (IV). ............................................................... 74
Table 9 Time to Complete scores (A, B, C, D) recoded into two categorical variables for each
Instructional Materials Condition (1) Slower Time to Complete, and (2) Faster Time to
Complete. .............................................................................................................................................. 76
Table 10 Descriptive Statistics for Percent Correct (DV2) as a continuous dependent variable
for Instructional Materials Conditions A, B, C, and D (IV). ............................................................... 77
Table 11 Descriptive Statistics for Errors (DV3) as a continuous dependent variable for
Instructional Materials Condition A, B, C, and D (IV). ....................................................................... 78
Table 12 Error scores (A, B, C, D) recoded into two categorical variables for each Condition
(1) Higher Number of Errors and (2) Fewer Number of Errors. ...................................................... 80
Table 13  Mental Rotations scores recoded into two categorical variables (1) High Spatial Ability and (2) Low Spatial Ability. .................................................................................................................. 81

Table 14  Descriptive Statistics for Can Do (DV4) as a nominal dependent variable for Instructional Materials Condition A, B, C, and D (IV). .................................................................................. 82

Table 15  Analysis of Variance for Percent Correct as the dependent variable and Instructional Material Conditions (A, B, C, and D) as the Independent Variable. ........................................... 83

Table 16  Analysis of Variance for Errors as the Dependent Variable and Conditions (A, B, C, D) as the Independent Variable ........................................................................................................... 84

Table 17  Analysis of Variance for Time as the Dependent Variable and Instructional Materials Conditions (A, B, C, D) as the Independent Variable. ............................................................................. 85

Table 18  Overall Chi Square analysis of Can Do (DV) and the Independent Variable Instructional Materials Condition (A, B, C, D) (Observed Frequencies) ............................................ 87

Table 19  Chi Square analysis of Can Do (DV4) and Prior Knowledge (IV) ............................................. 89

Table 20  Overall Chi Square analysis of Can Do (DV4) and Spatial Ability (IV) ................................. 91

Table 21  Chi Square analysis of Can Do B (DV4) and Spatial Ability (IV). Multiple Comparisons. ............................................................................................................................. 92

Table 22  Chi Square analysis of Can Do D (DV4) and Spatial Ability (IV). Multiple Comparisons. ............................................................................................................................. 93

Table 23  2 x 2 x 4 Analysis of Variance for Correct Responses as the within subjects Dependent Variable and Spatial Ability and Prior Knowledge as between subjects Independent Variables. ......................................................................................... 95
Table 24  2 x 2 x 4 Analysis of Variance for Seconds as the within subjects Dependent Variable and MRT and Prior Knowledge as between subjects Independent Variables........................ 97

Table 25  2 x 2 x 4 Analysis of Variance for Errors as the within subjects Dependent Variable and MRT and Prior Knowledge as between subjects Independent Variables......................... 99

Table 26  Overall Chi Square analysis of Can Do (DV4) and Time to Complete (IV)................. 101
CHAPTER 1

RESEARCH QUESTIONS AND LITERATURE REVIEW

INTRODUCTION

What is Multimedia?

According to the Merriam-Webster Online dictionary, the term “multimedia”, introduced in 1962, means using, involving, or encompassing several media. As technology progressed, other definitions followed. In 2004, IBM posted an expanded definition on their website that stated “computer-controlled presentations combining three or more of the following elements: text, graphics, animation, full-motion images, still video images, and sound. In 2005, Tom Antion’s Public Speaking Course website defined Multimedia as “the use of several media, such as movies, slides, music, and lighting in combination normally for the purpose of education or entertainment” (Antion, 2005, p. glossary/Multimedia). In 2008, Computer ServiceNETwork defined multimedia as “the use of a computer to display integrated text, graphics, animation, and sound”. As computers become more sophisticated and less expensive, the potential for use in multimedia presentations such as movies and interactive education increases” (Computer Service NETwork, 2008, p. glossary/Multimedia). These definitions have one common characteristic. They look at multimedia as the act of presenting words and pictures.
What is Multimedia Learning?

Those of us in education must look at student learning and build a working definition for learning that uses multimedia. Richard E. Mayer proposed that Multimedia learning is “building mental representations from words and pictures” and that Multimedia Instruction is “presenting words and pictures that are intended to promote learning” (Mayer, 2005, p. 3). Mayer, a professor of Psychology at the University of California in Santa Barbara, defined multimedia learning as learning from both words and pictures. His research in the 1990s (Mayer & Anderson, 1991; Mayer & Gallini, 1990) tested Pavio’s (1971; 1986) theory of dual coding with multimedia instruction. Mayer and his colleagues found that student scores were significantly better when it came to applying what they had learned after receiving multimedia instruction rather than a single media instruction. Other groups of researchers (Chandler & Sweller, 1991; Chandler & Sweller, 1996; Kalyuga, Ayers, Chandler, & Sweller, 2003; Mayer & Moreno, 1998; Sweller, 1994; Sweller, van Merrienboer, & Pass, 1998) confirmed these results. Some of the media tested included single media such as text, illustrations, photos, sounds, voice, animations, and video and multimedia combinations of two or more of those media used together. The experiments usually centered on cause and effect scenarios such as lightning striking (Mayer, Bove, Bryman, Mars, & Tapango, 1996), how brakes work (Mayer, 1989), how pumps work (Mayer & Gallini, 1990), or how a toilet flushes (Mayer, Hegarty, Mayer, & Campbell, 2005). From this growing body of research developed a set of principles of multimedia learning (Mayer, 2005). Those principles drive current research in Multimedia Learning. Studies in Multimedia Learning are concentrated in the content areas of Reading,
History, Mathematics, Chemistry, Meteorology, and Languages. What began in the 1960s as an integration of text and illustrations for textbooks has grown with the advances of digital content into a continuum of interactivity ranging from word processing through desktop publishing to multimedia, virtual reality, and simulated worlds. The exploration of Multimedia Learning in advanced computer-based contexts is in its infancy with a few studies in (1) virtual reality (Forman, Stanton, Wilson, & Duffy, 2003; Salzman, Dede, Loftin, & Chen, 1999; Wollensak, 2002) in (2) games, simulations and micro worlds (Gee, 2003), and in (3) hypermedia (Fabos, 2001; McDonald & Stevenson, 1998).

Today’s Multimedia Learning research adds to our understanding of how people learn from words and pictures in computer-based environments (Mayer, 2005). Those computer-based environments may include (1) online instructional presentations, (2) interactive lessons, (3) e-courses, (4) simulation games, (5) virtual reality, and (6) computer-supported in-class presentations.

**How is Multimedia Learning Used in a Graphics Curriculum?**

In the computer graphics classroom, it is common for students to encounter several different formats of information in at least three simultaneously delivered media, (1) text, in book or on the student computer screen or on a document projector screen in the classroom, (2) images, in the textbook or on the student computer screen or on a document projector screen in the classroom, and (3) sounds, emanating from the instructor’s voice, the student’s computer, or a projection of the instructor’s computer screen with a classroom sound system. These three delivery formats may be employed one-at-a-time, or combined in pairs or groups,
but most commonly for instructional purposes are (1) text only, as in a printed textbook with no images or illustrations, (2) text and images, as in a software manual showing text and screenshots of the computer screen, and (3) images and narration, as in an onscreen video or instructor demonstration. Though other combinations or variations of these conditions may exist, these three are the most commonly used in classroom training for graphics professionals. Along with text, images, and sound the student may interact with several media generators such as a desktop computer, monitor, and keyboard, and an overhead projector with audio speakers or personal earphones. It appears that the most common student tasks in graphics classes are procedural ones. In education, there are two main types of knowledge (1) declarative and (2) procedural. Declarative knowledge is to know and understanding factual knowledge about the world. Procedural knowledge is to know how to do something, or to perform the steps in an action or a process.

In a graphics classroom, the students interact with computers and texts to learn to perform sequences of steps that accomplish procedural tasks such as re-touching a photo, animating a drawn object, or editing a recorded video. The student must be able to generalize and internalize the procedure and transfer the actions to a similar but novel task.
RESEARCH QUESTIONS

This researcher’s objective is to use the existing research in Multimedia Learning to investigate how Multimedia Instruction affects learning a procedural task with computers. Despite the growing body of research on Multimedia Learning and Multimedia Instruction, only a few studies have looked at multimedia learning and multimedia instruction in learning procedural tasks (Michas & Berry, 2000; Palmiter & Elkerton, 1993; Pollock, Chandler, & Sweller, 2002). A procedural memory is an implicit long-term memory of how to execute a series of steps, for example, how to tie a shoe or ride a bike. A learned procedure becomes automatic. Palmiter and Elkerton (1993) found that during training, demonstration users were faster and more accurate than text-only users in learning a procedural task. Michas and Berry (2000) investigated the effectiveness of presenting procedural information through different combinations of media and found that (1) text and line drawings and (2) narrated video presentations were the best two combinations of media in their experiments.

Jeung, Chandler, & Sweller (1997) investigated using visual cues to direct attention in modified software training manuals. They found that learners remember more when multimedia presents with one source in visual mode and the other in auditory mode rather than both in visual mode. This effect was also studied with similar results by Mayer and Moreno (1998) and Moreno and Mayer (1999).

Marcus, Cooper, & Sweller, (1996) investigated using diagrams instead of text for teaching how to connect electronic resistors. They reported significantly increased efficiency
with diagrams alone. Van der Meij (2008) analyzed software and hardware manuals and found full-screen captures more beneficial than text or partial screens.

How do students learn a procedural task? How do they interact with different forms of training materials? The purpose of this investigation is to examine how students interact with software training materials when they consists of (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video and (D) Onscreen Narrated Video. Four versions of procedural task instructions will be developed or selected in the above formats and the student’s performance on a recall test and a transfer test assessed. Students will be administered a prior knowledge test and a spatial ability test before the procedural training.

**Research Question 1**

Are there are any significant differences in the student learning of a computer-based procedural task due to the format of the training materials?

A. Are there significant differences in the student learning between students trained with Traditional Textbook with Still Images and students trained with Modified Text with Integrated Still Images?

B. Are there significant differences in the student learning between students trained with Traditional Textbook with Still Images and students trained with Onscreen Modified Text with Silent Onscreen Video?
C. Are there significant differences in the student learning between students trained with Traditional Textbook with Still Images and students trained with Onscreen Narrated Video?

D. Are there significant differences in the student learning between students trained with Modified Text with Integrated Still Images, and students trained with Onscreen Modified Text with Silent Onscreen Video?

E. Are there significant differences in the student learning between students trained with Modified Text with Integrated Still Images, and students trained with Onscreen Narrated Video?

F. Are there significant differences in the student learning between students trained with Onscreen Modified Text with Silent Onscreen Video and students trained with Onscreen Narrated Video?

**Research Question 2**

Do individual differences in prior knowledge and spatial abilities make a difference in student learning?

A. Are there are any significant differences in the student learning of a computer-based procedural task due to individual differences in the learner’s prior knowledge of the subject matter?

B. Are there are any significant differences in the student learning of a computer-based procedural task due to individual differences in the learner’s spatial abilities?
LITERATURE REVIEW

The research on Multimedia Learning spans only about 10-12 years. Richard E. Mayer coined the term, and the area of study is referred to as the Cognitive Theory of Multimedia Learning. There are two major University centers for educational research in multimedia learning. The first is in the Department of Psychology at the University of California, Santa Barbara under the direction of Richard E. Mayer. The second is at the University of New South Wales, Sydney, Australia, spearheaded by Emeritus Professor John Sweller.

Throughout the 1990s, Mayer and his colleagues at Santa Barbara conducted many empirical research studies in multimedia learning and developed from their findings a set of seven principles for the design of multimedia messages and a cognitive theory of multimedia learning. Several core terms form the vocabulary of the research. (1) Multimedia Learning--learning from words and pictures, (2) Multimedia Message or Multimedia Presentation--presentation involving words and pictures, (3) Multimedia Instructional Message or Multimedia Instructional Presentation--presentation involving words and pictures that is intended to foster learning (Mayer, 2001).

Mayer’s Multimedia Learning Theory

According to this theoretical approach, there are three multimedia views: (1) the Delivery Media view, (2) The Presentation Modes view, and (3) the Sensory Modalities view. The Delivery Media view pertains to using two or more delivery devices for the instructional presentation. An example would be a lecturer’s voice and an overhead projector and speakers
showing a computer screen. The Presentation Mode view pertains to how the instructional material is presented, such as pictures or text. An example of picture and text representation would be on-screen text and animation or printed text and illustrations. Finally, the Sensory Modalities view is learner-centered and relies on the sensory receptors used by the learner to receive and process the instructional material such as the eyes or ears. Example of sensory input might be listening to narration and watching animation or listening to a lecture and viewing slides. This view takes into consideration research in working memory (Baddeley, 1992) and relies on channels for auditory and visual processing. Table 1 includes possible combinations of delivery materials and presentation modes.

Research in multimedia learning has been approached in two different conceptions of learning, (1) multimedia learning as information acquisition and (2) multimedia learning as knowledge construction. The first process is made up of three parts. The first part is the information, which is seen as an object, which can be moved from place to place. The second part is the learner who acts as a receiver who passively stores the information in memory. The third part is the teacher who is the information presenter. In the learning as knowledge construction view the learning is something that the learner must process to make sense of it. The learner accomplishes this through activities such as organizing, manipulating, and integrating the information. Mayer’s Cognitive Theory of Multimedia learning presumes that multimedia learning fosters active learning which in turn can promote meaningful learning. In other words, multimedia learning promotes both retention of the information as well as transfer of the information into creative solutions to novel problems.
Table 1

*Possible Combinations of Delivery Materials and Presentation Mode*

<table>
<thead>
<tr>
<th>Description of the Instructional Materials used in conjunction with a student’s computer workstation</th>
<th>Text On Screen</th>
<th>Text In book</th>
<th>Image Onscreen</th>
<th>Image In book</th>
<th>Sound Effect</th>
<th>Sound Narration</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Traditional Text book with Still Images</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>(2) Modified Text with Integrated Still Images</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>(3) Onscreen Modified Text with Silent Onscreen Video</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>(4) Onscreen Narrated Video</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
<td></td>
</tr>
</tbody>
</table>

The Cognitive Theory of Multimedia Learning consists of three assumptions, (1) Dual Channel Assumption, (2) the Limited Capacity Assumption, and (3) the Active-Processing Assumption. The Dual Channel Assumption is based in the dual coding work of Paivio (1986) and Baddeley’s working memory model (1992). Each expresses the idea that humans have separate processing channels for visual and auditory information. The Limited-Capacity Assumption was defined by the work of Miller’s (1956) memory span test, Baddeley’s (1986) definition of working memory, and Chandler & Sweller’s (1991) work on intrinsic cognitive load and extrinsic cognitive load. The Limited Capacity Assumption states that either channel can
only process a limited amount of information at a time. The Active-Processing Assumption is a newer assumption conceived by Wittrock (1989) and further developed by Cook and Mayer (1988) and Mayer (1999) where learners attend to incoming information and then actively manipulate it by organizing, classifying, and structuring it into an integrated mental representation that interacts with pre-existing knowledge. Seven principles guide the Cognitive Theory of Multimedia Learning. They are: (1) the Multimedia Principle, (2) the Spatial Contiguity Principle, (3) the Temporal Contiguity Principle, (4) the Coherence Principle, (5) the Modality Principle, (6) the Redundancy Principle, and (7) the Individual Differences Principle.

The Multimedia Principle states that students learn better from words and pictures than from words alone. This principle is based on the theoretical rational that when pictures and words are presented together a learner can build mental models and connections between them. This principle was tested in nine experiments: (Mayer & Anderson, 1991; Mayer & Anderson, 1992; Mayer, 1989; Mayer, Bove, Bryman, Mars, & Tapango, 1996; Mayer & Gallini, 1990). In each of these experiments, information retention was better for students receiving words and pictures than with words alone. The multiple representations groups in these experiments performed better on transfer tests, reinforcing the hypothesis that adding pictures to words resulted in increasing learner’s understanding of the material.

The Spatial Contiguity Principle states that students learn better, when corresponding words and pictures are presented near rather than far from each other on the page or screen. This principle is based on the theoretical rational that the learners are able to hold both picture and words in working memory longer due to their proximity which reduces the load on
cognitive processes. Mayer was involved in conducting five experiments testing the nearness of pictures and text (Mayer, 1989; Mayer, Steinhoff, Bower, & Mars, 1995; Moreno & Mayer, 1999). All of the five test groups experiencing words and pictures near each other on the page exhibited better retention. In texts using computer screens similar results confirmed that animations on screen near text were more effective than when they appeared far from each other.

**The Temporal Contiguity Principle** states that students learn better, when corresponding words and pictures appear simultaneously rather than in sequence. When presented simultaneously, the learner is better able to make sense or build connections between the verbal and visual than when separated by time in experiments (Mayer & Anderson, 1991; Mayer & Anderson, 1992; Mayer, Moreno, Boire, & Vagge, 1999; Mayer & Sims, 1994). All the experiments were time-based animations with narration presented in a computer-based environment. All learners took retention tests and transfer tests. Some learners experienced the information sequentially and some simultaneously. Three (of the five groups) experiencing simultaneous delivery of information recalled more relevant information than the groups experiencing the information in a sequential fashion. On tests of transfer and problem solving the groups who received simultaneously delivered information scored significantly higher than learners who received sequential information.

**The Coherence Principle** states that students learn better with minimal extraneous material. Extraneous, but interesting, material might include irrelevant words and pictures, music or sounds. Extraneous material, though it might be entertaining, diverts attention from
the important information. In 11 of 11 tests, learners experiencing concise multimedia presentations performed better on both tests of retention and on tests of transfer (Harp & Mayer, 1997; Harp & Mayer, 1998; Mayer, Bove, Bryman, Mars, & Tapango, 1996; Mayer, Heiser, & Lonn, 2001; Moreno & Mayer, 2000).

The Modality Principle states that students comprehend better from animation and narration than from animation with on-screen text. Animation comes in through the visual channel, and narration comes in through the auditory channel. Splitting the cognitive load between the visual and auditory channels is less taxing for the learner. In a set of four studies comparing retention and transfer performance of learners who received a narrated animation or the same animation with on-screen text Mareno & Mayer (1998; 1999) found that in all four studies, learners performed better on both retention and transfer tests if they received animation and narration.

The Redundancy Principle states that students learn better from animation and narration than from the combination of animation, narration, and text. Providing animation and text simultaneously can overload the visual channel and make the presentation less effective. In two tests, learners received animations, narrations, and text while others received animation and narration only. The learners receiving animation and narration performed better on both retention tests and transfer tests. Mayer, Heiser, and Lonn (2001) conducted the tests.

The Individual Differences Principle states that design effects are more important for low-prior-knowledge learners than for high-prior-knowledge learners, and for high-spatial-ability learners rather than for low-spatial-ability learners. Prior domain-specific knowledge aids
high-prior-knowledge learners to compensate for lack of guidance in presentations, and high-spatial-ability learners use their visualization abilities to integrate verbal and visual material in presentations. Low-prior-knowledge learners and low-spatial-ability learners seem to make the most dramatic improvements when presented with a multimedia presentation. In two empirical tests conducted by (Mayer & Gallini, 1990; Mayer, Steinhoff, Bower, & Mars, 1995), learners were separated into high and low prior-knowledge groups and subjected to well-designed instructional messages and to poorly designed instructional messages in a book-based environment. In one experiment, the poorly designed message was text alone, and the well-designed message was text and illustrations. In another experiment, the poorly designed message was text and illustrations where the illustrations were separate from the text. In all groups, there was a strong multimedia effect for low-prior-knowledge learners but not for high-prior-knowledge learners in retention tests. The well-designed materials were more effective for low-prior-knowledge learners. On transfer tests, the results were similar, with low-prior-knowledge learners making the most dramatic improvement.
Sweller’s Cognitive Load Theory

Learning occurs when information is made into chunks and transferred, through rehearsal, to long-term memory. Cognitive load theory originated in the 1980s, developed, and expanded through the 1990s. The theory is based on the idea that schemas or combinations of elements or “chunks” are the cognitive structures that make up an individual’s knowledge base. This builds upon the working memory research of George Miller (1956). Miller developed the concept of "chunking" and investigated the capacity of short-term memory. He presented the idea that short-term memory could only hold 5-9 chunks of information (seven plus or minus two) where a chunk is any meaningful unit. A chunk could refer to digits, words, chess positions, or people's faces. According to Sweller’s research, there are three categories of cognitive load (1) Intrinsic Cognitive Load, (2) Extrinsic Cognitive Load, and (3) Germaine Cognitive Load, and three specific effects related to cognitive load when learners process the information presented to them, (1) Split Attention Effect, (2) Redundancy Effect, and (3) Modality Effect.

**Intrinsic Cognitive Load** (Chandler & Sweller, 1991) is the inherent level of difficulty associated with instructional materials. Instructional materials vary in their levels of element interactivity. All elements have an inherent difficulty level. Some topics are more difficult than other topics. However, if instruction is designed so that difficult tasks are broken down into manageable parts and the parts taught individually, then the cognitive load decreases. Once the parts are committed to long-term memory as chunks or schemas, each chunk can be treated as a single element and recombined with other elements to create more chunks (Clark, Nguyen, &
Sweller, 2006). Thus, the intrinsic cognitive load of inherently difficult materials becomes more manageable.

**Extrinsic Cognitive Load** is unnecessary and can be controlled or engineered. For example, a verbal description of a square requires additional cognitive processing to understand a square, than a spatial representation or image of a square. This example is further discussed in John Sweller’s lecture on Extraneous Cognitive Load (2008) viewed on YouTube at [http://www.youtube.com/watch?v=RyuOU2RasRQ](http://www.youtube.com/watch?v=RyuOU2RasRQ).

**Germane Cognitive Load** refers to the effort that is required to construct schemas or mental models. Sweller, van Merrienboer, and Paas first described this concept in 1998. They suggested that extraneous load could be reduced through instructional design and that the redirected attention could be focused on schema construction. Consider the prior example of describing a square. Displaying a visual image of a square uses less extrinsic load to describe a square than employing a verbal description. It follows then; the remaining available attention is available to build a mental model of the procedure of mentally rotating a square or mentally making a building with blocks.

**A Split Attention Effect** can occur when instructional materials display two different forms of information at the same time. Splitting learner attention between text and a diagram or an illustration, increases cognitive load. It is more difficult to make sense of the information because the two inputs are combined then interpreted by the learner to have meaning (Chandler & Sweller, 1992). Combining the text and illustration into an integrated or labeled diagram minimizes the spilt attention effect.
The Redundancy Effect occurs when the same information occurs in multiple or unnecessarily elaborated forms. The additional information creates negative effects. Miller (1937) studied reading. He determined when teaching a child to read, if one shows a picture of a cow, says the word cow, and then the child sees the printed word cow...the redundancy of the picture causes an increase in the cognitive load. This is because the picture must be processed and has nothing to do with learning the configuration of the letters into the word “cow.” Non-essential images or text can have the same effect today of slowing the processing of essential information. Mayer, Heiser, and Lonn (2001) referred to this effect as the Redundancy Principle. Chandler and Sweller (1994; 1996) tested the redundancy effect on students learning to use a computer program and found that the computer sometimes interfered with intellectualizing the task. They experimented with several forms of a manual, (1) a traditional text-based manual, and a computer, (2) a modified manual with integrated diagrams, and no computer, and (3) a modified manual with a computer. In most cases, the student without a computer performed better.

The Modality Effect is a construct also investigated by Mayer. He called it the Modality Principle. People learn more deeply from multimedia messages when the words appear as spoken text rather than printed words. The research previously summarized supports the idea that processing visual information and auditory information can happen simultaneously in separate channels and decreases cognitive load, as long as the information is not redundant.
Lyons and Clark’s Guidelines for Training Materials

Dr. Ruth Colvin Clark and Chopeta Lyons have proposed that there are five main content types in lessons. They are (1) procedures, (2) concepts, (3) facts, (4) processes, and (5) principles (Clark & Lyons, 2004). Procedural content teaches the steps to perform routine tasks. An example of a procedural task would be using a computer software program to retouch a digital photograph. One retouches the photograph by sequentially performing a specific procedure on the computer. Conceptual content is a mental representation of a category. An example of a concept would be things that are “red”. Factual content is unique and specific information. For example, “A cell is the basic unit of life.” Process content communicates a flow of events, a series, or sequence. A principle is a task that completed in a unique way determined by work circumstances. It is a guideline.

Procedural content is commonly presented through demonstration and practice. Sometimes procedures are not learned by “doing” but are learned from some type of visual aid such as systematic written directions. Chandler and Sweller (1996) found when learning a computer software procedure, using a written manual is more successful when images of the computer screen are added.

Lyons and Clark (2003) propose five general guidelines for teaching procedural content; (1) provide demonstrations that combine transformational and representational visuals, (2) make sure that the transformational visuals are constructed from the learner’s viewpoint, (3) manage the cognitive load in visual presentations when the procedures or visuals are complex or when the learners are novices, (4) use visual cues to draw attention to warnings, and (5) in
online computer procedures, use on-screen contiguous text with transformational visuals to provide directions, feedback, and memory support.

**Demonstration Guidelines** suggest that the transformational and representational visuals should approximate the actual context of the equipment or physical setting of the task, (Clark & Mayer, 2008). In other words, make the visuals look as much as possible like the actual task. In training a computer task, it would be beneficial to show screenshots of the steps in the procedure. Representational visuals such as still screen captures or video screen captures of the procedure should be key components of computer training. For example, in constructing instructions for cropping a photo with a computer software program, it would be advisable to include images of what the computer program interface and tools look like at each step in the process. Figure 1 shows a computer screenshot of the procedure for cropping a photograph. It illustrates the operator dragging the cropping cursor diagonally across the image to define the area of the image that will remain after cropping. Figure 2 shows the next step in the sequence. It shows the opening of a dialog box soliciting information from the operator.

**The Learner’s Viewpoint** should be used for designing Transformation Visuals. Indicate movement with arrows on static graphics and orient the visuals from the learner’s viewpoint. If videos are used, present them as though from the eyes of the learner. Figure 3 shows an example of a static visual that uses arrows to direct the learners’ attention to actions that would occur on the computer screen. The arrows correspond to the numbered steps and the expected screen actions.
Figure 1. Computer interface at Step 1.

Figure 2. Computer interface at Step 2.
Complex Procedures should be managed for Novice Learners and for Instructionally Paced Materials. Visual cues draw attention to relevant areas in an illustration. The use of arrows or bulleted text can direct the learner’s focus inside the overall picture, making sure that the text is integrated with or near the relevant image. Eliminate extraneous detail and diagram complex spatial tasks to preserve efficiency, and conserve cognitive load. An example of cueing would be showing the cursor moving in a narrated instructional video so that the moving cursor directs the learner’s attention to the appropriate part of the screen. The screenshot in Figure 4 shows one frame in an instructional video using the moving cursor to direct the learners’ attention (Adobe Creative Team, 2007) reprinted by permission of
Pearson Education, Inc. The narrations should be coordinated to support the visual actions as they are happening.

Warnings should be prominently indicated. Make sure that warnings or cautions stand out on the page and that they appear before or during the action step they apply to. Warnings should be prominent and stand out in the materials. An example might look like this one in Figure 5 (Adobe Creative Team, 2007), reprinted by permission of Pearson Education, Inc.

The warning text is printed in an eye-catching red and appears in close proximity to the anticipated action on the screen.

Figure 4. Using a moving cursor.
**On-Screen Contiguous Text** should be used with Transformational Visuals to Provide Directions, Feedback, and Memory Support. All designs should include simulations and practice that duplicates the context of the procedure. In computer simulations, the help screens should be readily available and a learner should have the opportunity to re-play recorded demonstrations as many times as is necessary to learn the steps. In recorded video, it would be advisable if the replay button were prominently displayed. Figure 6 shows an example of a prominently displayed replay button on a training video. The learner may activate the replay by clicking on it. It always becomes available at the end of the video.
Building upon the guidelines proposed by Mayer, Sweller, Clark and Lyons, and their colleagues, instructional materials can be developed and tested for effectiveness. However, there are other considerations. In the field of Visual Communications which encompasses all communication that occurs through visual aids, including but not limited to signs, typography, drawing, graphic design, illustration web media, and television, effective visual design is evaluated by measuring the comprehension of the audience. While there are no universally agreed-upon standards for aesthetic qualities such as beauty or ugliness, there are established artistic design theories and guidelines for the layout and design of all types of advertising and communication artifacts, ranging from web pages to printed materials, packaging, and news media. If these design theories are applied to the design of instructional media, what other
useful guidelines may develop? Which ones are pre-existing in the theories and guidelines already discussed?

**Principles of Graphic Design**

Based on the literature of Ryan & Conover (2003), there are five principles of design. They are (1) balance, (2) proportion, (3) sequence, (4) emphasis, and (5) unity. These principles relate to each other and have symbiotic interconnection.

**Balance** is stability and equalizes the visual weight on either side of the vertical axis of a page. It appears in three ways, (1) symmetry, (2) asymmetry, and (3) optical weight. Symmetry is usually bilateral, meaning a mirror reflection on each side of the central axis. Center the artwork, text, and copy. Symmetry produces a feeling of formality, strength, and precision. Figure 7 illustrates the concept of bilateral symmetry.

![Figure 7. Example of Bilateral Symmetry.](image)
Asymmetry is informal balance. It is not centered on the vertical axis and is not weighted equally on each side. It is accomplished by counterbalancing the design elements so that visual balance is achieved through the juxtaposition of a variety of differing elements. Asymmetrical compositions have a feeling of playfulness, freedom, and movement. These layouts employ the use of optical weight as a design element. Optical weight is a visual system of measurement. Large elements weigh more than smaller elements. Color images weigh more than black and white images. Elements placed further away from the vertical center appear to weigh more. In Figure 8, the asymmetrical balance is achieved through combining varied sizes and optically weighted blocks. The larger blocks visually weigh more but are counterbalanced by the alternating placement of smaller ones.

*Figure 8.* Asymmetrical Balance and Optical Weight.
**Proportion** is the relationship between elements in a layout to each other and to the entire layout. Proportion in art can evoke emotional responses. One specific proportion that is widely studied is the Golden Ratio or the Golden Mean.

![Golden Mean Diagram](image)

*Figure 9. Proportions of the Golden Mean.*

This is a naturally occurring proportion that humans recognize as being pleasing. The mathematical ratio of parts is expressed as 1:1.618. Visually, the points of intersection are recommended as places to position important elements in a layout. Figure 9 illustrates the proportions and intersections of a rectangle showing the ratio of the Golden Mean. For humans, the most pleasing visual shape is the rectangle. Printed pages are rectangular because
the most pleasing page size is one in which the length is one-and-one-half times the width. The “rule of thirds” or ground thirds is a layout in which a rectangle is divided into nine equal parts by two-equally spaced horizontal lines and two equally spaced vertical lines. Points of interest reside at the intersections. Those intersections closely correspond to the major intersections of the Golden Mean. Figure 10 illustrates the division of a rectangle by the Rule of Thirds.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Rule of Thirds</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Figure 10.* Proportions of the Rule of Thirds.

In the proportional layout of the page, the optical center serves an important role. The optical center of a page layout is the spot where the human eye first enters the page. Humans tend to gravitate to an area on the page slightly above the mathematical center and just to the left of it. This sweet spot is a very strong and important area of the page. The most important information on the page resides here. In the layout of a book, the title page is a very good
example of employing this principle. The horizontally centered title rests slightly above the mathematical center of the page. Figure 11 illustrates this common title placement.

![Figure 11. Title placement above the mathematical center of a page.](image)

**Sequence** is the direction or reading pattern of the visual design. Normal eye tracking in occidental cultures tends to move from left to right and then from top to bottom. This visual pattern is sometimes called the “Z” readout. Sequencing patterns can determine the placement of elements on the page. Common sequencing conventions include, (1) more important information is usually placed higher up on the page, (2) information placed on the left side of the page is considered more valuable, (3) art or images are seen before plain text, and (4) placement of graphic elements like thumbnails, and photos can steer the reader’s eye through a page in a prescribed sequence. Element placement influences eye tracking. Cohn (2007)
studied the eye tracking of participants reading comic books to determine if the placement of the image cells would affect the “Z” readout westerners commonly employ in reading text. He confirmed that the “Z” readout is the preferred strategy but varies if there is no clear content in the upper left quadrant of the page. Figure 12 illustrates with an image of a vintage movie poster the “Z” page layout (Flickr.com) Reprinted under a Creative Commons License Deed. The viewer enters the page at the top left corner, looks right to the fortuneteller, follows downward to the left-center to the images of the actors, and then further left and downward to the text, which finishes in the lower right corner of the page. It is a typical “Z” pattern using a mixture of images and text.

*Figure 12.* “Z” Eye Tracking pattern.
Emphasis is giving one graphic element in the page visual significance. It is the focal point and stands out over all the rest. There are several strategies to increase the emphasis of an element. By tilting an image or block of text, you draw attention to it because it is in a different orientation than the other elements. By altering the focus on a photographic element, you can blur the non-essential material and force the focus to a particular part of the image. Extreme size differentials can set an element apart, as can differences in color or tone or contrasts of black and white. Using additional negative or white space can also set an element apart. In this Red Cross poster from the 1940s (Kaufmann, 1939), color provides emphasis (Figure 13). The size differential of the nurse against the smaller elements in the background also provides emphasis.

Figure 13. Using color and size for emphasis.
Unity is the overall look or coherence of a design. It is the total impact, accomplished through color harmony, structural order, style, typography, and texture. This example (Figure 14) uses a monochromatic pallet of green to produce color harmony and overall unity. The image displayed is the monochromatic illustration for the cover of a trade publication (The Radford Architectural Company, 1908) Reprinted under a Creative Commons License Deed.

![Figure 14](image.jpg)

*Figure 14.* Using color harmony for overall unity.

**Design Considerations for Typography and Text**

Through the careful arrangement of the type on the page and its size, style weight, and other specifications, effective communication through text and images is accomplished. Successful use of these tools makes messages easy to recognize and absorb. Ryan and Conover (2004) stated that everything including the art, typography, design, color, and style, should
work together in unity to reinforce the message. The ideal textual message is not only easy to read but visually engaging. Design considerations for textual materials have evolved in the printing and graphic design industry, some dating back to medieval time, and others proposed based on or validated by modern research in advertising, marketing, design, and education. The first of these considerations is the page layout.

**Ideal Page Layout Characteristics**

There are three rules of page layout based on the Golden Mean or the Golden Ratio. Primarily, the aspect ratio of the page should be 1: 1.618 or devised by the formula $a : b = b : (a + b)$ (Kane, 2002). The height of the text field should equal the width of the full page. The margins should be wide. The ideal formula for margins in the printing industry is that the top margin should equal 1.5 units, the side margins 2.0 units, and the bottom margin 3.0 units. For example, in an 8.5” by 11” page the top margin should be 1.5 inches, the side margins should be 2.0 inches each unless it is a two-page spread and then the gutter or inside margin should be 1.0 unit or 1.0 inches in this case. The bottom margin should be 3.0 inches. Using this formula, the text occupies approximately 40% of the page. Current textbooks use much smaller margins, between 1 and 1.5 inches, and are usually equilateral except for the binding edge. Figure 15 shows an example of two-page layouts. One the left is a diagram showing a grey area where text will be applied in the 40% ratio. The layout on the right is an image of page 43 in the book *Exploring Publication Design, 1E.* © 2006 Delmar Learning, a part of Cengage Learning, Inc. Reproduced by permission. www.cengage.com/permissions (Evans, 2006).
This formula is used as a guide for hand held books. The European page size system of A0 to A6 is based on a ratio of 24:34, which is an example of the Golden Ratio. Figure 16 shows the relationship of A0 through A6 page sizes to each other.
There are several general guidelines concerning the readability characteristics of the text itself. A typeface should maximize the readability of the text and express contemporary aesthetics. Tinker & Paterson (1929) reported that line lengths between three inches and three and a half inches were ideal. A rule of thumb is to keep the line length between 35 and 65 characters. Designers have also referred to this as the “2.5 alphabets” rule, because 2.5 x 26 letters is 65 characters. In some of the most common electronic typefaces used today 2.5 alphabets might look like those displayed in Figure 17.

Figure 16. European page sizes based on the Golden Ratio.

Ideal Text Readability Characteristics

There are several general guidelines concerning the readability characteristics of the text itself. A typeface should maximize the readability of the text and express contemporary aesthetics. Tinker & Paterson (1929) reported that line lengths between three inches and three and a half inches were ideal. A rule of thumb is to keep the line length between 35 and 65 characters. Designers have also referred to this as the “2.5 alphabets” rule, because 2.5 x 26 letters is 65 characters. In some of the most common electronic typefaces used today 2.5 alphabets might look like those displayed in Figure 17.

Figure 16. European page sizes based on the Golden Ratio.
Font size is also a concern. Font sizes are measured in points. There are 72 points in an inch. The true size of a letterform can vary though, according to typographical family because the font size designation is a reference to the old method of casting type in metal blocks or bases, and the measurement is based on the height of the metal base not the letterform upon it. Graphic designers consider paragraph text sizes to range from 10 to 12 points. This formula takes into consideration the common sizes of body text to be no larger than 12 points. The (British Dyslexia Association, 2009) suggests that for optimal word recognition and ADA accessibility the size range should be slightly larger at 12 to 14 points. This recommendation allows for a little larger than normal font to aid the reader in letter recognition. Figure 18 shows the difference between a line of representative text set in 12-point type and in 14-point type.
Another font characteristic discussed is the shape of the individual letterforms. For maximum readability the font should be rounded, and have adequate space between the letters. It is a generally held assumption among designers that san serif fonts are easier to read than ones with serifs. Examples of san serif fonts are Arial, Comic Sans, Verdana, Helvetica, Tahoma, or Trebuchet because they are good examples of rounded fonts with adequate space between letters. Figure 19 shows an example of four san serif fonts.

<table>
<thead>
<tr>
<th>Arial:</th>
<th>Abcdefghijklmnopqrstuvwxyzabcdefgijklm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comic Sans:</td>
<td>Abcdefghijklmnopqrstuvwxyzabcdefgijklmn</td>
</tr>
<tr>
<td>Verdana:</td>
<td>Abcdefghijklmnopqrstuvwxyzabcdefgijkl</td>
</tr>
<tr>
<td>Tahoma:</td>
<td>Abcdefghijklmnopqrstuvwxyzabcdefgijklm</td>
</tr>
</tbody>
</table>

Figure 19. Suggested san-serif fonts.
Principles of Design, Instructional Materials, and Multimedia Learning

The purpose of producing instructional materials is to communicate information. Engaging, organized, easy to read, and aesthetically pleasing information may entice learners to attend to it more effectively than a less enticing version of the same information.

Educational researchers have proposed some general guidelines to follow in producing examples of ideal text-based training materials. There are also theoretical constructs in the field of graphic design that outline fundamental design principles governing page layout and design of printed materials. These include universal principles such as (1) Balance, (2) Proportion, (3) Rhythm, (4) Emphasis, and (5) Unity, to achieve an aesthetically pleasing result that is easily readable and successfully communicates the message to the intended audience.

Multimedia design theory defines best practices for arranging visual elements for inclusion in texts to maximize delivery of the message. These graphics design principles apply to layouts containing text and image elements. In the last five years, corporate training research has added guidelines and defined characteristics for effectively designing training materials that employ narrations, sound, animation, or movies. Thus, the present study investigates differences in student learning of a computer-based procedural task due to (1) the design of the training materials, (2) prior knowledge, or (3) spatial ability, or a combination of those three independent variables, as mentioned previously in the research questions. The present study, which includes custom-designed instructional materials, will adhere to visual communications best practices research in designing the four conditions of the instructional materials in order that the most effective example of each Instructional Material Condition is used in the study.
The following illustration is an example of an analysis of Graphics Principles of Design applied to a page of the custom-designed Instructional Materials.

Figure 20. Example of a Principle of Graphics Design Page Analysis.
In this representative page, The Rule of Thirds is indicated in red, and the two color illustrations are placed near the intersections of lines on the right of the page. On the left of the page, the intersections are near the beginning of the chunked lists. Both placements indicate that the information is of importance. The green arrowed line is the indication of the “Z” reading pattern for occidental cultures. Notice that the horizontal top of the “Z” pattern leads the reader to see the header for the document then leads the reader down the page in a left diagonal through the chunked list and illustrations to the bottom of the page and the page turn. The main information divided into chunks of 3-5 items or steps is accompanied by illustrations that show the steps, as they would be performed on the computer screen. The illustrations were chosen for their ability to convey location of the tools and sequence of the steps. An arrow that shows where it corresponds to the illustration accompanies each step in the listing. All text on the page is at least 12-point type, and some of it is larger than that. Colored images were chosen for their clarity in displaying the results of the process. The amount of characters, words, and images on the page were purposefully kept as brief as possible and surrounded by maximum white space in order provide the essential information while limiting the cognitive load.
CHAPTER 2

METHOD

Participants

The participants for this study will be approximately 36 sophomore and junior students in two sections of an undergraduate introductory three credit-hour graphics computer-literacy course. See Appendix A for instructor’s consent form. Both males and females will be included, and the age range will be restricted to students over the age of 18 for this undergraduate sample. Each will sign a voluntary consent form.

Research Design

The research format is a 2 x 2 x 4 mixed model design with two between-subjects independent variables and one within-subjects independent variable. The between-subjects independent (categorical) variables will be Prior Knowledge with (1) below median vs. (2) above median knowledge levels, and Spatial Ability with (1) below median vs. (2) above median spatial abilities levels. The within-subjects independent variable will be Instructional Material Conditions with (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video, and (D) Onscreen Narrated Video. This within-subjects independent variable is repeated measures in which the four instructional material conditions (A, B, C, D) will be counterbalanced. Thus, in this counterbalanced set of conditions, the order of the tasks (1, 2, 3, 4) would be the same for each
participant, but the order of the Instructional Material Conditions will be all possible ordered sequences of (A, B, C, D) or (B, C, D, A), (C, D, A, B), (D, A, B, C).

This counterbalancing arrangement would yield a fair comparison among the Instructional Material Conditions. The dependent variables will be (1) Time to Complete, (2) Correct Responses, (3) Errors, and (4) Can Do. These dependent variables are further defined in the subsequent section on Procedure. This 2 x 2 x 4 research design is illustrated in Table 2.

Table 2

*Research Design, 2 by 2 by 4 Mixed Model with Three Independent Variables (IV) and Four Dependent Variables (DV)*

<table>
<thead>
<tr>
<th>Prior Knowledge (Categorical IV)</th>
<th>Spatial Ability (Categorical IV)</th>
<th>Instructional Material Conditions (IV)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Low</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B</td>
</tr>
<tr>
<td></td>
<td>High</td>
<td>C</td>
</tr>
<tr>
<td>High</td>
<td>Low</td>
<td>D</td>
</tr>
</tbody>
</table>

Note 1: Condition A. Traditional Textbook with Still Images
          Condition B. Modified Text with Integrated Still Images
          Condition C. Onscreen Modified Text with Silent Onscreen Video
          Condition D. Onscreen Narrated Video

Note 2: The four Conditions will be counterbalanced with four Tasks so that each Condition will be measured under different (fair-testing assortment) materials.

Note 3: DV 1. Time to Complete
        DV 2. Correct Responses
        DV 3. Errors
        DV 4. Can Do
The counterbalanced arrangement of Four Conditions with Four Tasks is illustrated in Table 3.

### Table 3

**Counterbalanced Four Tasks with Four Conditions**

<table>
<thead>
<tr>
<th>Person</th>
<th>Task (1, 2, 3, 4) / Condition (A, B, C, D)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1A  2B  3C  4D</td>
</tr>
<tr>
<td>2</td>
<td>1B  2C  3D  4A</td>
</tr>
<tr>
<td>3</td>
<td>1C  2D  3A  4B</td>
</tr>
<tr>
<td>4</td>
<td>1D  2A  3B  4C</td>
</tr>
<tr>
<td>5</td>
<td>1A  2B  3C  4D</td>
</tr>
<tr>
<td>6</td>
<td>1B  2C  3D  4A</td>
</tr>
<tr>
<td>7</td>
<td>1C  2D  3A  4B</td>
</tr>
<tr>
<td>8</td>
<td>1D  2A  3B  4C</td>
</tr>
<tr>
<td>9</td>
<td>1A  2B  3C  4D</td>
</tr>
<tr>
<td>10</td>
<td>1B  2C  3D  4A</td>
</tr>
<tr>
<td>11</td>
<td>1C  2D  3A  4B</td>
</tr>
<tr>
<td>12</td>
<td>1D  2A  3B  4C</td>
</tr>
</tbody>
</table>

Continued as appropriate for the Number of Participants

**Note 1:** The four Tasks (1, 2, 3, and 4) involve different materials designed to allow fair testing of each participant across the four Conditions (A, B, C, D).
Instructional Materials

There are four Instructional Material Conditions. These are (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video, and (D) Onscreen Narrated Video. Condition A, consisting of “Traditional Textbook with Still Images “will be selected for each of the Tasks (1, 2, 3, 4). The pages in the training booklet for Task 1, Condition A appear in Figures 21 and 22.

Figure 21. Cover page and Page 2 of the Task 1A Booklet (Adobe Creative Team, 2007) .

Reprinted by permission of Pearson Education, Inc.
In Figures 21 and 22 Instructional Material Conditions A – Task1A (Traditional Textbook with Still Images) is illustrated. The booklet employs an embedded copy of a typical textbook page. The embedded page describes the procedure. It consists of an introductory paragraph followed by a numbered list of steps with a picture showing the results of step three, followed by an image of a dialog box related to step four. The second embedded page continues with step five, followed by the image showing the results of step five, followed by the continuing instructions for step six. Booklet instructions beneath the embedded page image instruct participants not to continue until directed to do so. Booklet Page 4 contains the instructions for completing the recall and transfer test for Task 1A. Note that the images in the embedded
pages often show the result of the procedural step and do not visually show the action. The participant is also provided with a sample digital image file with which to practice the same procedure described in the training materials.

Condition B consists of “Modified Text with Integrated Still Images” and will be designed for each of the four Tasks (1, 2, 3, and 4). An example of the pages in the Task 1, Condition B training booklet is shown in Figures 23 and 24. In the figures, Instructional Material Conditions B (Modified Text with Integrated Still Images) is illustrated showing instructional pages with the procedure steps divided into three manageable chunks. Each chunk consists of three or four numbered steps with an accompanying transformational illustration. There are arrows directing the participant’s attention from each numbered step to the part of the illustration that relates to the action described in the step. To maximize the effectiveness of the materials design, care was taken to place text on the left side of the page with the illustrations following on the right in accordance with the common “Z” reading pattern. The participant also has a digital image file with which to practice the same procedure described in the training materials.
Figure 23. Cover page and Page 2 of the Task 1B Booklet (Adobe Creative Team, 2007).

Reprinted by permission of Pearson Education, Inc.
The participants are instructed at the bottom of page 3 not to continue until directed to do so. Page 4 contains the instructions for completing the recall and transfer test for Task 1B.

Condition C consists of “Onscreen Modified Text with Silent Onscreen Video” and designed for each of the four Tasks (1, 2, 3, and 4). In Figures 25 and 26, Instructional Material Conditions C (Onscreen Modified Text with Silent Onscreen Video) is illustrated showing a single page with instructions directing the participant to view the Onscreen Silent Training Video.

Figures 25 and 26 display the training booklet pages and a screenshot of the video for Task 1, Condition C. The onscreen video demonstrates the actions of the procedural steps. The student accesses the video content by clicking on a file link on the computer desktop. The participant can replay the video. The participant is also provided with a sample digital image file with which to practice the same procedure that is described in the training video.
Figure 25. Cover page and Page 2 of the Task 1C Booklet.
Figure 26. Screenshot of the Task 1C Training Video and Page 3 of the Task 1C Booklet.
Condition D consists of “Narrated Onscreen Video” and is designed for each of the four Tasks (1, 2, 3, and 4). An example of the training booklet for Task 1 Condition D is shown in Figures 27 and 28 illustrate the Instructional Material Conditions D.

![Task 1D Booklet](image)

**Figure 27.** Cover page and Page 2 of the Task 1D Booklet.

(Narrated Onscreen Video) showing a single page with instructions directing the participant to view the Onscreen Narrated Video. The video demonstrates the actions of the procedural steps. The student accesses the video content by clicking on a file link on the computer desktop. The participant can replay the video. The participant is also provided with a sample digital image file with which to practice the same procedure that is described in the training video.
Figure 28. Screenshot of the Task 1D Training Video and Page 3 of the Task 1D Booklet. (Adobe Creative Team, 2007). Reprinted by permission of Pearson Education, Inc.
A Spatial-Ability Pretest will be administered to each participant. An example of the pages in the Spatial Ability Pretest booklet is shown in Figures 29, 30, and 31.

Figure 29. Cover page and Page 2 of the MRT (Mental Rotation Test) Booklet.

Figure 30. Page 3 and Page 4 of the MRT (Mental Rotation Test) Booklet.
A Prior Knowledge pretest will be administered consisting of ten multiple-choice questions about the four tasks. An example of the pages in the Prior-Knowledge Pretest booklet is shown in Figures 32 and 33.
Figure 32. Cover page and Page 2 of the Pretest Booklet.

Figure 33. Page 3 and 4 of the Pretest Booklet.
Procedure

Participants were recruited via their enrollment in a Graphics computer literacy course. See Appendix B for West Virginia University IRB approval and Fairmont State University and Pierpont Community and Technical College Approval. There were two administrations of the experimental procedures. The investigator conducted both sessions with two helpers. There were 19 students enrolled in the first class and 18 students enrolled in the second class. On the administration day eight students attended the first class and all eight participated in the study. In the second class 12 students attended and all students participated in the study. Therefore the original number of participants in this study was 20. In the first class, participants filled seats 101, 102, 103, 104, 105, 106, 107, and 108. Their seat numbers became their participant numbers. In the second class the same system was used with the exception of seat number 210. The participant in seat 209 was hearing impaired and her note taker sat in seat 210. The note taker remained in attendance but did not assist the participant during the data collection.

Room Set-up, data collection for each participating class occurred during the students’ regularly assigned class time. All data was collected at one administration in one day. Computer workstations were employed at each station was assigned a participant number. Participants were instructed to fill the seats near the front of the room first and not to leave any empty spaces the computers were numbered as described in Table 4.
Table 4

*Participant Number at Workstations*

<table>
<thead>
<tr>
<th>Front of Room</th>
</tr>
</thead>
<tbody>
<tr>
<td>101/201 102/202 103/203 104/204</td>
</tr>
<tr>
<td>117/217 118/218</td>
</tr>
</tbody>
</table>

Note 1: In the first class participants occupied workstations 101-108. In the second class, participants occupied workstations 201-209 and 211-213.

*Workstation Set Up* included labeling each of the stations with the two participant numbers. 100-level numbers identified a session-one-participant and 200-level numbers identified a session-two-participant. On the desk at the base of the computer monitor facing the participant, a 3 x 3 inch label displayed the participant number. An identical set of numbers affixed to the back of the monitors assisted the helpers in pairing numbered test packets with corresponding workstations. The identically formatted computer monitors each displayed two desktop folders. The numerically labeled folders corresponded with the participant numbers for that workstation. Each folder contained only the materials necessary for that participant’s version of the training and testing materials. The materials schedule follows in Table 5.
Table 5

*Materials Schedule for Computer Workstations.*

<table>
<thead>
<tr>
<th>Testing Packet</th>
<th>Participant Folders</th>
<th>Tasks</th>
</tr>
</thead>
</table>
Headsets were provided for each WorkStation. New ear bud type headsets were provided for each class’s administration of the testing. Some participants used their own personal ear buds instead. It is common for students to use ear buds in the regularly scheduled class to review training videos and to listen to personal music files while completing design work in class.

Introduction to the Study was orally presented and a written summary was given to each participant once all participants arrived. See Appendix C for the Recruitment Script. The voluntary consent form was explained and the participants were given the opportunity to sign the voluntary consent form or to leave. The consent forms were collected. See Appendix D for the Voluntary Consent Form. When all questions were answered, the pre-numbered testing packets were distributed. The numbering system on the packets corresponded to the seating numbers at the workstations thus ensuring the counterbalancing of materials. The counterbalancing was set up as previously described in Table 3.

Instructions and testing materials were arranged sequentially in each participant’s packet. Each training session and testing session was timed with a stopwatch, and time prompts were given orally and visually by hand signals. Each training session was timed for 7 minutes with prompts given at (1) start, (2) 4 minutes left, (3) 2 minutes left, (4), and (5) stop. The participants were prompted orally and in a text statement at the bottom of the training page not to turn the page to the test until instructed to do so. Testing for each task immediately followed the training for that task, contained a parallel task and reference to the training
materials was prohibited during the testing. Testing was timed and prompted in the same manner as the training. The tests were limited to 5 minutes. Each test was timed with a stop watch and oral prompts given at (1) start, (2) 3 minutes left, (3) 2 minutes left, (4) 1 minute left, and (5) stop.

**Helpers** assisted at each test collection session. The same two helpers assisted both times. Both were trained together before the sessions. A printed summary of the training was also provided to them. See Appendix E for the Helper Training Sheet. Both helpers were adjunct instructors in the graphics program, familiar with the computer workstations and competent to assist with any technical difficulties that might arise.

**Screen Recording Software Training** was conducted for participants after they signed the consent form. The participants were trained to start and stop the data collection software Jing by Techsmith. The interface had been pre-programmed to save the screen recordings of the students’ tests to a folder on the desktop that was numbered the same as the workstation number. Students were able to practice starting and stopping the screen capture procedure before beginning the data collection.

**Participant Folders** were copied to a jump drive at the end of each testing session. Participant folders from session one were removed from the desktops prior to beginning the session two data collection. This insured the integrity of each data folder. When the data collection process was completed all the data was backed up from the jump drive to the researcher’s desktop hard drive and to an additional external hard drive.
Data Collection

The Mental Rotation Test (MRT) is a spatial ability inventory. Mental rotation tests are often used as aptitude tests to estimate the capacity of three-dimensional thinking and spatial ability. The classical Mental Rotation Test (MRT) used in this study is a cognitive test where a number of similar, three-dimensional, geometric figures are presented on paper to a test subject. These figures are rotated in different dimensions in relation to each other in a specific amount of degrees (e.g., 0°, 60°, 120°, or 180°). The subject is then supposed to determine whether any of the figures are identical. There are two correct responses in each set. To be able to decide if two figures are identical or not, the subject had to perform a mental rotation of the figures. Participants had three and a half minutes to complete the ten questions by circling the correct responses in the testing booklet. Images of the booklet were previously shown in Figures 29, 30, and 31. See Appendix F for the Testing booklet used in the current study. Completed MRT test booklets were collected by the Investigator and helpers. The MRT results were used to sort the subjects into high and low spatial ability groups.

The Mental Rotations Test (Vandenberg, 1978), was based on the Shepherd-Metzler mental rotations test (1971). Vandenberg’s measure contained 20 items in 5 sets of 4 items. Each item consists of a criterion figure, two correct alternatives, and two incorrect ones. Half of the items are mirror-images and half are rotated images. It takes about 10 minutes to administer and has been used with college students, high school students, and elementary students. It may be used to study the development of spatial ability. In a large sample (3,268 subjects), the test displayed a substantial internal consistency (Kuder-Richardson 20 = .88), in a
sample of 336 subjects a test-retest correlation of .83 was reported and was consistent with other measures indicated strong association with test of spatial visualization and virtually no association with tests of verbal ability. The test has been used with a sample of 197 undergraduate students with shortened time limits. The test was divided in half, using only 10 test items and shortening the time to 3.5 minutes. In that study, the test was statistically significant at the < .01 level.

**Prior Knowledge** test booklets (previously shown in Figures 32 and 33) were distributed after completing the MRT. See Appendix G for the Prior Knowledge Test Booklets. Participants had ten minutes to take the Prior Knowledge Pretest. This is a paper and pencil test consisting of ten multiple-choice questions. These questions measure the extent of a subject’s specific prior knowledge of the information or concepts contained in the content testing materials. Participants circled the correct response on the test booklet. The Investigator and helpers collected the completed Prior Knowledge test booklets. The results were used to sort the subject pool into high and low Prior Knowledge groups.

**The Tasks** test booklets were distributed next. The Participants had seven minutes to complete the training for Task 1 and then had five minutes to complete the testing for Task 1. Task 1 consisted of applying an automatic color adjustment to an image using an image editing computer software program. The participant had seven minutes to review the training lesson. There were four different conditions of the lesson distributed to the participants. They were (A) Traditional Textbook with Still Images (Figures 21 and 22), (B) Modified Text with Integrated Still Images (Figures 23 and 24), (C) Onscreen Modified Text with Silent Onscreen Video (Figures
25 and 26), and (D) Onscreen Narrated Video (Figures 27 and 28). Detailed descriptions and images of the training materials are shown in Figures 21 through 28. Actual training materials are included in Appendix H (Task 1; A, B, C, D), Appendix I (Task 2; A, B, C, D), Appendix J (Task 3; A, B, C, D), and Appendix K (Task 4; A, B, C, D). During the training phase, the participant was provided with a computer, the image editing software, and the sample digital image file with which to practice the skill. See Table 6 for a chart of the lengths of the training videos.

Table 6

*Duration of Training Videos*

<table>
<thead>
<tr>
<th>Training Video</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1-Onscreen Modified Text with Silent Onscreen Video</td>
<td>0:03:17;24</td>
</tr>
<tr>
<td>Task 1-Onscreen Narrated Video</td>
<td>0:03:17;24</td>
</tr>
<tr>
<td>Task 2-Onscreen Modified Text with Silent Onscreen Video</td>
<td>0:02:14;24</td>
</tr>
<tr>
<td>Task 2-Onscreen Narrated Video</td>
<td>0:02:14;24</td>
</tr>
<tr>
<td>Task 3-Onscreen Modified Text with Silent Onscreen Video</td>
<td>0:03:34;27</td>
</tr>
<tr>
<td>Task 3-Onscreen Narrated Video</td>
<td>0:03:34;27</td>
</tr>
<tr>
<td>Task 4-Onscreen Modified Text with Silent Onscreen Video</td>
<td>0:04:22;00</td>
</tr>
<tr>
<td>Task 4-Onscreen Narrated Video</td>
<td>0:04:22;00</td>
</tr>
</tbody>
</table>

*Note 1:* The Duration of each video for a numbered task is the same in Narrated or Silent because the video track is identical.
There was a numbered file folder on the computer desktop for saving the files. When the seven minutes of training were complete, each participant was instructed to close the training section of the booklet and open the testing page. Each participant had five minutes to apply the newly trained skill to a novel digital image and save the file to the designated desktop folder.

Participants were not permitted to refer back to the training materials during the parallel testing segment. Estimated completion time base upon observations of similar tasks performed in photo editing classes by graphics students, was two to three minutes. During the testing phase of this task, screen recording software recorded all movements on each computer screen so that the order of the steps, timing, and errors could be measured for each participant. The screen recordings were saved in the designated folders on the desktop and were analyzed later to obtain measurements or counts for the dependent variables: (1) Time to Complete, (2) Correct Responses, (3) Errors, and (4) Task Completion, or Can Do. Each subsequent task (2, 3, and 4) followed the same training and testing pattern.

After completing all four tasks, the Participants were debriefed by the Investigator and then departed. All participants except Participant 213 attempted all tasks as observed by the researcher and helpers at the data collection sessions. Participant 213, after completing the Prior Knowledge pretest and the Mental Rotations test, browsed the Internet from their workstation instead of participating in the remaining data collection. This participant remained at the workstation until the data collection session ended but did not attempt any of the four tasks. Therefore, there are no scores for Participant 213 on Instructional Materials Conditions 2A, 3B, 4C, or 1D.
Time to Complete each task for each participant was recorded as a real-time recording of the computer screen as the student completed the task. That time was written on the scoring forms as it appeared in the video in the format “Minutes: Seconds; Frames Recorded.” The data was converted to seconds and rounded to the whole number then recorded in columns on the data spreadsheet.

Data Analysis

Inter-Rater Reliability for scoring the four tasks was addressed by selecting three observers to each code the screen recordings of the same 10% of the Participant’s completed tasks. The observers were selected based on their availability for participation in the study and their high level of familiarity with the image editing software program used by the Participants to complete the computer tasks. Each of the observers had previous experience in using and teaching the use of the image-editing program. Two of the observers were adjunct faculty members who assisted in collecting the data and the third was a recent graduate of the graphics program with two years of graphics industrial experience. Coding training was conducted in a group with all three observers. Examples of the scoring rubrics were used to practice coding dummy data. See Appendix L for an example of the training materials. The results from the observer’s practice coding were evaluated by the researcher and based on the inter-rater reliability of their coding. Inter-rater reliability was calculated by the total number of agreements between the three observers divided by the total number of observations and multiplied by 100. Observer training continued until 90% inter-rater reliability was achieved. An
example of the coding rubric is shown in Figure 34. A copy of the entire coding rubric is located in Appendix M.

Participant anonymity was protected by assigning numerical identifiers. Participants in the first administration were assigned numbers 101, 102, 103, and so forth. Participants in the second administration were assigned numbers 201, 202, 203, and so forth. All participants answered each question of the Mental Rotations Tests. A complete data set was collected.

![Sample Coding Rubric](image)

*Figure 34. Sample Coding Rubric.*

The Independent Variable Spatial Ability (MRT) was scored according to the answer key in the test manual, the data was described as raw scores, and results transferred to summary data sheets. Data was entered into the database management program. The raw scores were used to identify the participants as having High Spatial Ability or Low Spatial Ability by comparing the raw scores to the median. The median is that point in a distribution above and
below which are 50% of the scores. All scores below the median were coded as 0, and all scores of above the median were coded as 1. These scores divided the participants into two groups: (1) Participants with a High Spatial Ability and (2) participants with a Low Spatial Ability.

The Prior Knowledge Test was scored by comparing the objective items against an answer key. See Appendix N for the answer key. All participants answered each question. A complete data set was collected. The raw scores were transferred to summary data sheets. Data was entered into the database management program. Correct answers were coded as 1 and incorrect answers coded as 0 for each individual question. Each participant’s total score was compared against the median. All scores below the median were coded as 0, and all scores above the median were scored as 1. These scores divided the participants into two groups: (1) participants with a high level of prior knowledge and (2) participants with a low level of prior knowledge. The Prior Knowledge pretest was developed by this researcher and a colleague for use in the current study. The 10 questions were selected from the Final Exam Test bank of questions developed for an undergraduate image-editing course that both instructors teach. The test bank was aligned with the Adobe Photoshop CS3 textbook used in the course. That course book provided the basis for the Traditional Textbook Condition (A) for all four Instructional Materials tasks. Four independent raters scored the alignment of the individual test questions to the content of the four Instructional Materials tasks using a 5-point Likert scale where 1 = does not measure the concept, and 5 = measures the concept well. Each question was matched to task content. Table 7 illustrates the content pairing. Appendix O contains the Prior Knowledge Pretest Validity Instrument. The mean score for 4 raters on the
total questions on a 5-point scale was 46.5, so there was a 93% agreement that the questions were appropriately assessing the assigned topics.
Table 7

*Content Pairing of Prior Knowledge Pretest and the four Tasks*

<table>
<thead>
<tr>
<th>Test Item</th>
<th>Task Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Task 1: Step 4</td>
<td>Prior knowledge of the location of the Shadows/Highlights tool</td>
</tr>
<tr>
<td>2</td>
<td>Task 2: Steps 4, 5, 6, 7</td>
<td>Prior knowledge of the use of the Crop tool</td>
</tr>
<tr>
<td>3</td>
<td>Task 3: Steps 6, 7, 8,</td>
<td>Prior knowledge of the Levels drop-down menu</td>
</tr>
<tr>
<td>4</td>
<td>Task 2: Step 3</td>
<td>Prior knowledge of the identification of the crop tool icon</td>
</tr>
<tr>
<td>5</td>
<td>Task 4: Step 3</td>
<td>Prior knowledge of the identification of the healing brush</td>
</tr>
<tr>
<td>6</td>
<td>Task 1: Step 3, 4, 5</td>
<td>Prior knowledge using and interpreting the levels histogram</td>
</tr>
<tr>
<td>7</td>
<td>Task 4: Step 5, 6</td>
<td>Prior knowledge of image retouching using the healing tool</td>
</tr>
<tr>
<td>8</td>
<td>Task 2:</td>
<td>Prior knowledge of advanced capabilities of the crop tool</td>
</tr>
<tr>
<td>9</td>
<td>Task : 4</td>
<td>This question assesses a knowledge point at the intermediate skill level</td>
</tr>
<tr>
<td>10</td>
<td>Task : 2</td>
<td>Prior knowledge of the appropriate tool for removing color cast</td>
</tr>
</tbody>
</table>
**The Data for the Dependent Variables** were recorded as follows: (1) Time to Complete was collected in minutes and seconds; (2) number of Correct Responses were counted; (3) number of Errors were counted; (4) whether the participant Can Do /Cannot Do the procedure was coded numerically, 0 = Cannot Do and 1 = Can Do. For each Task (1, 2, 3, 4) a rubric detailing key sequential steps was constructed. These rubrics were used to score the test videos. Each video was viewed and the completion times, correct responses, and errors were noted and recorded on a summary cover sheet. For Task 1 the total possible correct responses were nine. For Task 2 the total possible correct responses were nine. For Task 3 the total possible correct responses were 11. For Task 4 the total possible correct responses were 17. For all correct response scores a percent correct score was computed. Since the conditions (A, B, C, D) were the dependent variable and the tasks (1, 2, 3, 4) were the repeated measure, a percent score was needed for statistical analysis instead of a raw count in order to allow comparisons across the counterbalanced cases.

**Scoring Error Counts** for Tasks 1, 2, 3, and 4 were accomplished by counting one error for each mouse click or keyboard action that did not progress toward the sequential steps as prescribed in the instructions and listed on the scoring rubric. It was critical in these tasks that the steps be performed in order. A description of common errors was included in the scoring training materials so that all raters could score using the same definitions. A score of Can Do was recorded if the participant was successful in completing the task regardless of the number of errors in the sequence of steps. A score of Cannot Do was recorded if the task was not completed.
The data set was imported into SPSS, a computerized statistical analysis software package. Means, standard deviations, and frequencies were reported. A statistical significance of $p < .05$ was used. A 2 by 2 by 4 mixed model analysis of variance (ANOVA) was computed for each of the three continuous dependent variables, (1) Time to Complete, (2) Correct Responses, (3) Errors. In each of these ANOVAs, Prior Knowledge (low versus high) was a between-subjects independent variable, Spatial Ability (low versus high) was a between-subjects independent variable, and Instructional Material Conditions (A, B, C, D) was a within-subjects independent variable. Thus, a three-way mixed-model ANOVA was computed for Time to Complete (DV1), Correct Responses (DV2), and Errors (DV3). Each of these ANOVAs will yield a main effect for Prior Knowledge, a main effect for Spatial Ability, a main effect for Instructional Material Conditions, two-way interaction (3 of them), and the three-way interaction. Multiple comparisons (Tukey Test) were computed as necessary following statistically significant effects. For example, a statistically significant finding for the Instructional Material Conditions main effect would require a multiple comparisons test. In addition, a statistically significant finding for the Spatial Ability by Prior Knowledge interaction would require multiple comparisons test. A 2 x 2 x 4 Chi Square analysis was used to interpret the effects of the independent variables on the Can Do dependent variable. This Can Do (Can Do vs. Cannot Do) dependent variable is dichotomous and can be appropriately interpreted using Chi Square. Tables and graphic interpretation will be presented. The statistical results will be interpreted and discussed to provide implication for educational application.
CHAPTER THREE

RESULTS

Purpose

The purpose of this study was to compare student learning of computer-based procedural tasks and the effects of Prior Knowledge and Spatial Ability on the student learning. The dependent variables of (1) Time to Complete, (2) Correct Responses, (3) Errors, and (4) Can do were used to measure the within-subjects independent variable of instructional material conditions with four counterbalanced repeated measures (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video, and (D) Onscreen Narrated Video. The effects of Prior Knowledge and Spatial Ability on student learning of computer-based procedural tasks were investigated as between-subjects independent variables. Scores for participant’s Prior Knowledge and Spatial Ability were collected first, and then the dependent variable scores were collected. The data for the dependent variables consisted of scores based participants’ screen recordings while completing the four counterbalanced tasks. The researcher coded the screen recordings and three additional raters scored ten percent of the recordings for reliability. The data for the independent variables consisted of scores based on (1) Mental Rotations Test and the (2) Prior Knowledge Pretest.
Descriptive Data

This section provides a summary of the descriptive data for the participants’ scores in the study. The descriptive data include the (1) Time to Complete, (2) Percent Correct, (3) Errors, (4) Can Do counts for each of the four repeated measures, (5) high and low Spatial Ability ratings and (6) high and low Prior Knowledge ratings.

Means, Standard Deviations, and frequencies were reported. A statistical significance of < .05 was used. A 2 x 2 x 4 mixed model analysis of variance (ANOVA) was computed for each of the three continuous dependent variables, (1) Time to Complete, (2) Correct Responses (Percent Correct), and (3) Errors. In each of these ANOVAs, Prior Knowledge (low versus high) was a between-subjects independent variable, Spatial Ability (low versus high) was a between-subjects independent variable, and Instructional Material Conditions (A, B, C, D) was a within-subjects independent variable. Thus, a three-way mixed-model ANOVA was computed for Time to Complete (DV1), Correct Responses (DV2), and Errors (DV3). Each of these ANOVAs was evaluated for a main effect for Prior Knowledge, a main effect for Spatial Ability, a main effect for Instructional Material Conditions, two-way interaction (3 of them), and a possible three-way interaction. Multiple comparisons (Tukey Test) may be computed as necessary following statistically significant effects. For example, a statistically significant finding for the Instructional Material Conditions main effect would require a multiple comparisons test. In addition, a statistically significant finding for the Spatial Ability by Prior Knowledge interaction would require multiple comparisons tests. A 2 x 2 x 4 Chi Square analysis will be used to interpret the effects of the independent variables on the Can Do dependent variable. This Can Do (Can Do vs.
Cannot Do) dependent variable is dichotomous and can be appropriately interpreted using Chi Square D. The continuous dependent variables were also coded as categorical data by comparing the scores against the median. Tables and graphic interpretation will be presented. The statistical results will be interpreted and discussed to provide implication for educational application.

**Time to Complete** data are summarized in Table 8 including the minimum and maximum completion times in seconds. The Means and Standard Deviations for participants’ scores on Time to Complete for each of the four image editing tasks are arranged by Condition (A, B, C, and D).

### Table 8

*Descriptive Statistics for Time to Complete (DV1) as a continuous dependent variable for Instructional Materials Conditions A, B, C, and D (IV).*

<table>
<thead>
<tr>
<th>Condition</th>
<th>N</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Mean</th>
<th>Std. Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition A</td>
<td>19</td>
<td>65</td>
<td>300</td>
<td>141.84</td>
<td>72.49</td>
</tr>
<tr>
<td>Condition B</td>
<td>19</td>
<td>32</td>
<td>300</td>
<td>129.84</td>
<td>75.29</td>
</tr>
<tr>
<td>Condition C</td>
<td>19</td>
<td>53</td>
<td>300</td>
<td>152.32</td>
<td>80.80</td>
</tr>
<tr>
<td>Condition D</td>
<td>19</td>
<td>29</td>
<td>300</td>
<td>135.42</td>
<td>83.04</td>
</tr>
</tbody>
</table>

Valid N (List wise) 19

Note 1: For any missing value a code of 300 was entered because all participants attempted to complete the task. Those who were not able to complete the task used all available time for their attempt.
Time to Complete scores were also coded categorically for each of the four Instructional Materials Conditions (A, B, C, D). The median scores for each condition are shown in Table 9.

Those scores above the median labeled as (1) Slower Time to Complete and those scoring below the median labeled as (2) Faster Time to Complete.
Table 9

Time to Complete scores (A, B, C, D) recoded into two categorical variables for each Instructional Materials Condition (1) Slower Time to Complete, and (2) Faster Time to Complete.

<table>
<thead>
<tr>
<th>Scores</th>
<th>Frequency</th>
<th>Percent</th>
<th>Valid Percent</th>
<th>Cumulative Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>9</td>
<td>47.4</td>
<td>47.4</td>
<td>47.4</td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>52.6</td>
<td>52.6</td>
<td>100.0</td>
</tr>
<tr>
<td>Valid A</td>
<td>Total</td>
<td>19</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>0</td>
<td>9</td>
<td>47.4</td>
<td>47.4</td>
<td>47.4</td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>52.6</td>
<td>52.6</td>
<td>100.0</td>
</tr>
<tr>
<td>Valid B</td>
<td>Total</td>
<td>19</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>0</td>
<td>9</td>
<td>47.4</td>
<td>47.4</td>
<td>47.4</td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>52.6</td>
<td>52.6</td>
<td>100.0</td>
</tr>
<tr>
<td>Valid C</td>
<td>Total</td>
<td>19</td>
<td>100.0</td>
<td>100.0</td>
</tr>
<tr>
<td>0</td>
<td>9</td>
<td>47.4</td>
<td>47.4</td>
<td>47.4</td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>52.6</td>
<td>52.6</td>
<td>100.0</td>
</tr>
<tr>
<td>Valid D</td>
<td>Total</td>
<td>19</td>
<td>100.0</td>
<td>100.0</td>
</tr>
</tbody>
</table>

Note: 0 = Slower Time to Complete  
1 = Faster Time to Complete
**Percent Correct** data are summarized in Table 10 including the minimum and maximum Percent Correct, Means, Standard Deviations and Variance for participants’ scores on Percent Correct for each of the four image editing tasks arranged by Instructional Materials Condition (A, B, C, and D).

Table 10

*Descriptive Statistics for Percent Correct (DV2) as a continuous dependent variable for Instructional Materials Conditions A, B, C, and D (IV).*

<table>
<thead>
<tr>
<th></th>
<th>N</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Mean</th>
<th>Std. Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>A Percent Correct</td>
<td>19</td>
<td>0</td>
<td>100</td>
<td>77.97</td>
<td>31.82</td>
</tr>
<tr>
<td>B Percent Correct</td>
<td>19</td>
<td>0</td>
<td>100</td>
<td>79.74</td>
<td>25.12</td>
</tr>
<tr>
<td>C Percent Correct</td>
<td>19</td>
<td>0</td>
<td>100</td>
<td>70.20</td>
<td>30.96</td>
</tr>
<tr>
<td>D Percent Correct</td>
<td>19</td>
<td>0</td>
<td>100</td>
<td>70.96</td>
<td>36.69</td>
</tr>
<tr>
<td>Valid N (List wise)</td>
<td>19</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note 1: For any missing value a code of 0 was entered because all participants made an attempt to complete the task with that participant providing no correct answers.
Errors data are summarized in Table 11 including the minimum and maximum Error Count, Means, Standard Deviations and Variance for participants’ Errors for each of the four image editing tasks arranged by Instructional Materials Condition (A, B, C, and D).

Table 11

Descriptive Statistics for Errors (DV3) as a continuous dependent variable for Instructional Materials Condition A, B, C, and D (IV).

<table>
<thead>
<tr>
<th></th>
<th>N</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Mean</th>
<th>Std. Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors A</td>
<td>17</td>
<td>0</td>
<td>19</td>
<td>4.12</td>
<td>5.41</td>
</tr>
<tr>
<td>Errors B</td>
<td>18</td>
<td>0</td>
<td>13</td>
<td>1.94</td>
<td>3.30</td>
</tr>
<tr>
<td>Errors C</td>
<td>17</td>
<td>0</td>
<td>15</td>
<td>2.25</td>
<td>4.49</td>
</tr>
<tr>
<td>Errors D</td>
<td>16</td>
<td>0</td>
<td>11</td>
<td>1.13</td>
<td>2.71</td>
</tr>
</tbody>
</table>

Note 1: Missing Values were omitted case by case.
Errors scores were also coded categorically for each of the four Instructional Materials Conditions (A, B, C, and D). The median scores for each condition are shown in Table 12. Those scores above the median labeled as (1) Higher Number of Errors and those scoring below the median labeled as (2) Fewer Number of Errors.
Table 12

Error scores (A, B, C, D) recoded into two categorical variables for each Condition (1) Higher Number of Errors and (2) Fewer Number of Errors.

<table>
<thead>
<tr>
<th>Scores</th>
<th>Frequency</th>
<th>Median</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>Valid A Total</td>
<td>19</td>
<td>2.00</td>
</tr>
<tr>
<td>0</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Valid B Total</td>
<td>19</td>
<td>.50</td>
</tr>
<tr>
<td>0</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Valid C Total</td>
<td>19</td>
<td>0.00</td>
</tr>
<tr>
<td>0</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Valid D Total</td>
<td>19</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Note 1: 0 = Fewer Number of Errors
1 = Higher Number of Errors
**Spatial Ability** data were obtained through the Mental Rotations Test, scored using the provided answer key and then coded categorically. Those scores above the median (8.0) labeled as (1) High Spatial Ability and those scoring below the median labeled as (0) Low Spatial Ability.

Table 13

*Mental Rotations scores recoded into two categorical variables (1) High Spatial Ability and (2) Low Spatial Ability.*

<table>
<thead>
<tr>
<th>Scores</th>
<th>Frequency</th>
<th>Percent</th>
<th>Valid Percent</th>
<th>Cumulative Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>9</td>
<td>47.4</td>
<td>47.4</td>
<td>47.4</td>
</tr>
<tr>
<td>1</td>
<td>10</td>
<td>52.6</td>
<td>52.6</td>
<td>100.0</td>
</tr>
<tr>
<td>Valid</td>
<td>Total</td>
<td>19</td>
<td>100.0</td>
<td>100.0</td>
</tr>
</tbody>
</table>

**Note:** 0 = *Low Spatial Ability*  
1 = *High Spatial Ability*
Can Do data are summarized in Table 14 including the minimum and maximum Can Do Count, Means, and Standard Deviations for participants’ Can Do or Cannot Do for each of the four image editing tasks arranged by Instructional Materials Condition (A, B, C, and D). Total Can Do scores were coded categorically for the combined Instructional Materials Conditions (A, + B + C + D). Those scores above the median (2.63) labeled as (1) Can Do and those scoring below the median labeled as (2) Cannot Do

Table 14

*Descriptive Statistics for Can Do (DV4) as a nominal dependent variable for Instructional Materials Condition A, B, C, and D (IV).*

<table>
<thead>
<tr>
<th></th>
<th>N</th>
<th>Minimum</th>
<th>Maximum</th>
<th>Mean</th>
<th>Std. Deviation</th>
<th>Can Do Sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Do A</td>
<td>19</td>
<td>0</td>
<td>1</td>
<td>.58</td>
<td>.507</td>
<td>11</td>
</tr>
<tr>
<td>Can Do B</td>
<td>19</td>
<td>0</td>
<td>1</td>
<td>.79</td>
<td>.419</td>
<td>15</td>
</tr>
<tr>
<td>Can Do C</td>
<td>19</td>
<td>0</td>
<td>1</td>
<td>.63</td>
<td>.496</td>
<td>12</td>
</tr>
<tr>
<td>Can Do D</td>
<td>19</td>
<td>0</td>
<td>1</td>
<td>.63</td>
<td>.496</td>
<td>12</td>
</tr>
</tbody>
</table>

Note 1: Can Do = 1
      Cannot Do = 0
Research Question 1:

Are there any significant differences in student learning of a computer-based procedural task due to the format of the training materials?

A vs. B vs. C vs. D performance on Percent Correct scores. A one-way within subjects ANOVA was conducted to compare the effects of the Instructional Materials Conditions (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video, and (D) Onscreen Narrated Video on Percent Correct scores on learning a computer based procedural task. There was no significant effect of the Materials Condition on Percent Correct. \( F(3, 54) = .5, \quad > .05 \) suggesting that no differences exist in the participants’ Percent Correct scores due to the format of the training materials. See Table 15 for the ANOVA summary.

Table 15

Analysis of Variance for Percent Correct as the dependent variable and Instructional Material Conditions (A, B, C, and D) as the Independent Variable.

<table>
<thead>
<tr>
<th>Source</th>
<th>SS</th>
<th>df</th>
<th>ms</th>
<th>ms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td>1335.52</td>
<td>3</td>
<td>445.27</td>
<td>.681</td>
</tr>
<tr>
<td>Error</td>
<td>47723.96</td>
<td>54</td>
<td>883.78</td>
<td></td>
</tr>
<tr>
<td>Subjects</td>
<td>23340.03</td>
<td>18</td>
<td>1296.67</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>72399.81</td>
<td>75</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A vs. B vs. C vs. D on Error Counts. A one-way within subjects ANOVA was conducted to compare the effects of the Instructional Materials Conditions (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video, and (D) Onscreen Narrated Video on Error scores on learning a computer based procedural task. There was no significant effect of the Materials Condition on Errors. \( (3, 33) = 1.124, \quad > .05 \) suggesting that no differences exist in the student Error scores due to the format of the training materials. See Table 16 for an ANOVA summary.

Table 16

**Analysis of Variance for Errors as the Dependent Variable and Conditions (A, B, C, D) as the Independent Variable**

<table>
<thead>
<tr>
<th>Source</th>
<th>SS</th>
<th>df</th>
<th>ms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Errors</td>
<td>56.50</td>
<td>3</td>
<td>18.83</td>
</tr>
<tr>
<td>Error</td>
<td>553.00</td>
<td>33</td>
<td>16.76</td>
</tr>
<tr>
<td>Subjects</td>
<td>243.17</td>
<td>11</td>
<td>22.11</td>
</tr>
<tr>
<td>Total</td>
<td>852.67</td>
<td>47</td>
<td></td>
</tr>
</tbody>
</table>

Note 1: Missing observations deleted list wise. \( N = 12 \).
A vs. B vs. C vs. D on Time To Complete scores. A one-way within subjects ANOVA was conducted to compare the effects of the Instructional Materials Conditions (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video, and (D) Onscreen Narrated Video on Time to Completed scores for learning a computer based procedural task. There was no significant effect of the Materials Condition on Time to Complete. \( F(3, 54) = .309, \quad > .05 \) suggesting that no differences exist in the student Time to Complete scores due to the format of the training materials. See Table 17 for the ANOVA Summary.

Table 17

Analysis of Variance for Time as the Dependent Variable and Instructional Materials Conditions (A, B, C, D) as the Independent Variable.

<table>
<thead>
<tr>
<th>Source</th>
<th>SS</th>
<th>df</th>
<th>ms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time</td>
<td>5303.62</td>
<td>3</td>
<td>1767.87</td>
</tr>
<tr>
<td>Error</td>
<td>308842.13</td>
<td>54</td>
<td>5719.30</td>
</tr>
<tr>
<td>Subjects</td>
<td>129413.66</td>
<td>18</td>
<td>7189.65</td>
</tr>
<tr>
<td>Total</td>
<td>443559.41</td>
<td>75</td>
<td></td>
</tr>
</tbody>
</table>


A vs. B vs. C vs. D on Performance of Completing Tasks. The number of participants completing tasks for each of the Instructional Materials Conditions (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C) Onscreen Modified Text with Silent Onscreen Video, and (D) Onscreen Narrated Video on Percent Correct scores, was compared with a 2 Can Do x 4 Materials Conditions Chi Square. The conditions were not significantly different from each other, $\chi^2 (3) = 2.12, > .05$. See Table 18 for the Overall Chi Square.
Table 18

Overall Chi Square analysis of Can Do (DV) and the Independent Variable Instructional Materials Condition (A, B, C, D) (Observed Frequencies)

<table>
<thead>
<tr>
<th>Condition</th>
<th>Can Do</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td>Expected</td>
<td>Observed</td>
<td>Expected</td>
<td>Observed</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>12.5</td>
<td>6.5</td>
<td>8</td>
<td>n=19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>12.5</td>
<td>6.5</td>
<td>4</td>
<td>n=19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>12.5</td>
<td>6.5</td>
<td>7</td>
<td>n=19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>12.5</td>
<td>6.5</td>
<td>7</td>
<td>n=19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>df</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Chi Square 2.12 overall (df = 3)

Total 38 50 38 26 N=76

Note 1: For any missing value a code of 0 was entered because for all participants an attempt was made to complete the task. All failed attempts were coded as Cannot Do.

Note 2: Data was coded as Can Do = 1; and Cannot Do = 0
Research Question 2:

Do individual differences in Prior Knowledge and Spatial Abilities make a difference in student learning?

A. Are there any significant differences in student learning of a computer-based procedural task due to individual differences in the learner’s prior knowledge of the subject matter?

Can Do vs. Prior Knowledge. A 2 x 2 Chi Square was conducted to compare whether students who could do the tasks by Condition A, B, C, D, differed with respect to their Prior Knowledge of the computer software. An overall significance was found. \( \chi^2 = 8.7, \quad p < .01 \) suggesting that there is a difference in Can do or Cannot Do based on Prior Knowledge of the participant. 72\% of participants who had High Prior Knowledge were able to complete a task. Multiple comparisons revealed that for Condition B; \( \chi^2 = 6.81, \quad p < .01 \) was significant.
### Table 19

**Chi Square analysis of Can Do (DV4) and Prior Knowledge (IV)**

<table>
<thead>
<tr>
<th>Prior Knowledge</th>
<th>Can Do</th>
<th></th>
<th></th>
<th></th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>No</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expected</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>No</td>
<td>19</td>
<td>16</td>
<td>19</td>
<td>24</td>
<td>n=40</td>
</tr>
<tr>
<td>Yes</td>
<td>19</td>
<td>10</td>
<td>19</td>
<td>26</td>
<td>n=36</td>
</tr>
<tr>
<td><strong>df</strong></td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td><strong>Chi Square</strong></td>
<td>8.7 overall (df = 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>38</td>
<td>26</td>
<td>38</td>
<td>50</td>
<td>N=76</td>
</tr>
</tbody>
</table>

**Note 1:** For any missing value a code of 0 was entered because for all participants an attempt was made to complete the task. All failed attempts were coded as Cannot Do.

**Note 2:** Data was coded as Can Do = 1; and Cannot Do = 0.
A. Are there any significant differences in student learning of a computer-based procedural task due to individual differences in the learner’s spatial abilities?

**Can Do vs. Spatial Ability.** A 2 x 2 Overall Chi Square was conducted to compare whether students who could do the tasks by Conditions A, B, C, D differed with respect to their Spatial Ability. An overall significance was found. \( \chi^2 = (1) = 8.7, \quad < .01 \) suggesting that there is a difference in Can do or Cannot do based on Spatial Ability of the participant and 70% of participants who had High Spatial Ability were able to complete a task. Multiple comparisons revealed that for Condition B; \( \chi^2 = (1) = 7.66, \quad < .01 \) was significant in that there was a higher number than expected that could do the task, 90% of the participants who could do the task also had High Spatial ability. Condition D was also statistically significant; \( \chi^2 = (1) = 3.87, \quad = < .05 \) and 80% of the participants who could do a task also had a High Spatial Ability level. 39% of those who had Low Spatial Ability could not do the task. See Table 20 for the overall Chi Square summary, Table 21 for the multiple comparisons for Condition B, and Table 22 for the multiple comparisons for Condition D.
Table 20

**Overall Chi Square analysis of Can Do (DV4) and Spatial Ability (IV)**

<table>
<thead>
<tr>
<th>Spatial Ability</th>
<th>Can Do</th>
<th></th>
<th></th>
<th></th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Expected</td>
<td>Observed</td>
<td>Yes</td>
<td>Expected</td>
</tr>
<tr>
<td>0</td>
<td>19</td>
<td>14</td>
<td>19</td>
<td>22</td>
<td>n=40</td>
</tr>
<tr>
<td>1</td>
<td>19</td>
<td>12</td>
<td>19</td>
<td>28</td>
<td>n=36</td>
</tr>
<tr>
<td>df</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Chi Square: 8.7 overall (df = 1)

Total: 38, 26, 38, 50, N=76

Note 1: For any missing value a code of 0 was entered because all participants made an attempt to complete the task. All failed attempts were coded as Cannot Do.

Note 2: Data was coded as Can Do = 1; and Cannot Do = 0.
Table 21

*Chi Square analysis of Can Do B (DV4) and Spatial Ability (IV). Multiple Comparisons.*

<table>
<thead>
<tr>
<th>Spatial Ability</th>
<th>Can Do B</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Expected</td>
<td>Observed</td>
</tr>
<tr>
<td>0</td>
<td>4.8</td>
<td>3</td>
</tr>
<tr>
<td>1</td>
<td>4.8</td>
<td>1</td>
</tr>
<tr>
<td>df</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Chi Square</td>
<td>7.66</td>
<td>(df = 1)</td>
</tr>
</tbody>
</table>

Note 1: For any missing value a code of 0 was entered because all participants made an attempt to complete the task. All failed attempts were coded as Cannot Do.

Note 2: Data was coded as Can Do = 1; and Cannot Do = 0.
Table 22

*Chi Square analysis of Can Do D (DV4) and Spatial Ability (IV). Multiple Comparisons.*

<table>
<thead>
<tr>
<th>Spatial Ability</th>
<th>Can Do D</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>No</td>
<td>Yes</td>
<td>Total</td>
<td>Expected</td>
<td>Observed</td>
</tr>
<tr>
<td>0</td>
<td>4.8</td>
<td>5</td>
<td>4.8</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>4.8</td>
<td>2</td>
<td>4.8</td>
<td>8</td>
<td>n=10</td>
<td></td>
</tr>
<tr>
<td>df</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Chi Square</td>
<td>3.87 (df = 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td></td>
<td></td>
<td>N=19</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note 1: For any missing value a code of 0 was entered because all participants made an attempt to complete the task. All failed attempts were coded as Cannot Do.

Note 2: Data was coded as Can Do = 1; and Cannot Do = 0.
A 2 x 2 x 4 Analysis of Variance for Percent Correct (DV2) was computed. Instructional Materials Conditions (A, B, C, D), was a within-subjects Independent Variable. Spatial Ability and Prior Knowledge were between subjects Independent Variables. There was no significant between subjects effect for Spatial Ability compared to Prior Knowledge \( (1, 45) = .15, > .05 \) and there were no significant within subjects effects comparing Percent Correct and Spatial Ability \( (3, 45) = .1.4, > .05 \); and for Percent Correct vs. Prior Knowledge \( (3, 45) = .41, > .05 \). See Table 23 for the ANOVA Summary.
### Table 23

**2 x 2 x 4 Analysis of Variance for Correct Responses as the within subjects Dependent Variable and Spatial Ability and Prior Knowledge as between subjects Independent Variables.**

<table>
<thead>
<tr>
<th>Source</th>
<th>SS</th>
<th>df</th>
<th>ms</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Between Subjects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intercept</td>
<td>103276.7</td>
<td>1</td>
<td>103276.7</td>
<td>276.54</td>
</tr>
<tr>
<td>MRT</td>
<td>153.70</td>
<td>1</td>
<td>153.70</td>
<td>.41</td>
</tr>
<tr>
<td>PriorK</td>
<td>14.50</td>
<td>1</td>
<td>14.48</td>
<td>.04</td>
</tr>
<tr>
<td>MRT*PriorK</td>
<td>56.23</td>
<td>1</td>
<td>56.23</td>
<td>.15</td>
</tr>
<tr>
<td>Error</td>
<td>56.2</td>
<td>15</td>
<td>373.47</td>
<td></td>
</tr>
<tr>
<td><strong>Within Subjects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent</td>
<td>1535.20</td>
<td>3</td>
<td>511.73</td>
<td>.56</td>
</tr>
<tr>
<td>Percent*MRT</td>
<td>3718.66</td>
<td>3</td>
<td>1239.62</td>
<td>1.37</td>
</tr>
<tr>
<td>Percent*PriorK</td>
<td>1116.32</td>
<td>3</td>
<td>372.11</td>
<td>.41</td>
</tr>
<tr>
<td>Percent<em>MRT</em>PriorK</td>
<td>1214.78</td>
<td>3</td>
<td>409.93</td>
<td>.44</td>
</tr>
<tr>
<td>Error</td>
<td>41127.17</td>
<td>45</td>
<td>913.94</td>
<td></td>
</tr>
<tr>
<td>Subjects</td>
<td>129413.66</td>
<td>18</td>
<td>7189.65</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>178125.79</td>
<td>75</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A 2 x 2 x 4 Analysis of Variance for Time to Complete (DV1) was computed. Instructional Material Conditions (A, B, C, D) was a within-subjects Independent Variable. Spatial Ability and Prior Knowledge were between subjects Independent Variables. There was no significant between subjects effect for Spatial Ability compared to Prior Knowledge \((1, 45) = .14, \ > .05\) and there were no significant within subjects effects comparing Time vs. Spatial Ability \((3, 45) = .55, \ > .05\); and for Time vs. Prior Knowledge \((3, 45) = 1.01, \ > .05\); a comparison of Time vs. Spatial Ability vs. Prior Knowledge was also not significant at \((3, 45) = 1.16, \ > .05\) See Table 24 for the ANOVA Summary.
**Table 24**

*2 x 2 x 4 Analysis of Variance for Seconds as the within subjects Dependent Variable and Spatial Ability and Prior Knowledge as between subjects Independent Variables.*

<table>
<thead>
<tr>
<th>Source</th>
<th>SS</th>
<th>df</th>
<th>ms</th>
<th>F</th>
<th>p</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Between subjects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intercept</td>
<td>349049.04</td>
<td>1</td>
<td>349049.04</td>
<td>187.76</td>
<td>.00</td>
</tr>
<tr>
<td>MRT</td>
<td>3.13</td>
<td>1</td>
<td>3.13</td>
<td>.48</td>
<td>.51</td>
</tr>
<tr>
<td>PriorK</td>
<td>6.27</td>
<td>1</td>
<td>6.27</td>
<td>.96</td>
<td>.36</td>
</tr>
<tr>
<td>MRT*PriorK</td>
<td>.09</td>
<td>1</td>
<td>.09</td>
<td>.01</td>
<td>.92</td>
</tr>
<tr>
<td>Error</td>
<td>52.25</td>
<td>8</td>
<td>6.53</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Within subjects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Seconds</td>
<td>1560.67</td>
<td>3</td>
<td>1520.22</td>
<td>.27</td>
<td>.85</td>
</tr>
<tr>
<td>Seconds*MRT</td>
<td>9415.47</td>
<td>3</td>
<td>3138.49</td>
<td>.55</td>
<td>.65</td>
</tr>
<tr>
<td>Seconds*PriorK</td>
<td>17301.69</td>
<td>3</td>
<td>5767.23</td>
<td>1.01</td>
<td>.40</td>
</tr>
<tr>
<td>Seconds<em>MRT</em>PriorK</td>
<td>19903.98</td>
<td>3</td>
<td>6634.66</td>
<td>1.16</td>
<td>.34</td>
</tr>
<tr>
<td>Error</td>
<td>257375.45</td>
<td>45</td>
<td>5719.45</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>305557.26</td>
<td>75</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A 2 x 2 x 4 Analysis of Variance for Errors (DV3) was computed. Instructional Materials Condition 9 (A, B, C, and D) was a within-subjects Independent Variable. Spatial Ability and Prior Knowledge were between subjects Independent Variables. There was no significant between subjects effect for Spatial Ability compared to Prior Knowledge (1, 45) = .01, > .05 and there were no significant within subjects effects comparing Errors vs. Spatial Ability (3, 45) = .10, > .05; and for Errors vs. Prior Knowledge (3, 45) = 1.81, > .05; a comparison of Errors vs. Spatial Ability vs. Prior Knowledge was also not significant at (3, 45) = .37, > .05. See Table 25 for the ANOVA Summary.
Table 25

*2 x 2 x 4 Analysis of Variance for Errors as the within subjects Dependent Variable and Spatial Ability and Prior Knowledge as between subjects Independent Variables.*

<table>
<thead>
<tr>
<th>Source</th>
<th>SS</th>
<th>df</th>
<th>ms</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Between subjects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intercept</td>
<td>47.80</td>
<td>1</td>
<td>47.80</td>
<td>7.32</td>
</tr>
<tr>
<td>MRT</td>
<td>3.13</td>
<td>1</td>
<td>3.13</td>
<td>.48</td>
</tr>
<tr>
<td>Prior K</td>
<td>6.27</td>
<td>1</td>
<td>6.27</td>
<td>.96</td>
</tr>
<tr>
<td>MRT*PriorK</td>
<td>.09</td>
<td>1</td>
<td>.09</td>
<td>.01</td>
</tr>
<tr>
<td>Error</td>
<td>52.25</td>
<td>8</td>
<td>6.53</td>
<td></td>
</tr>
<tr>
<td><strong>Within subjects</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Errors</td>
<td>43.28</td>
<td>3</td>
<td>14.43</td>
<td>.81</td>
</tr>
<tr>
<td>Errors*MRT</td>
<td>5.28</td>
<td>3</td>
<td>1.76</td>
<td>.10</td>
</tr>
<tr>
<td>Errors*PriorK</td>
<td>96.60</td>
<td>3</td>
<td>32.20</td>
<td>1.82</td>
</tr>
<tr>
<td>Errors<em>MRT</em>PriorK</td>
<td>19.90</td>
<td>3</td>
<td>6.63</td>
<td>.37</td>
</tr>
<tr>
<td>Error</td>
<td>425.77</td>
<td>24</td>
<td>17.74</td>
<td></td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>590.83</td>
<td>75</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
A. Are there any significant differences in student learning of a computer-based procedural task due to individual differences in the learner’s time to complete?

**Can Do vs. Time to Complete.** A 2 x 2 Chi Square was conducted to compare whether students who could do the tasks (total) differed with respect to the Time to Complete the tasks (total High or Low). An overall significance was found; \( \chi^2 (1) = 13, \quad < .001 \) suggesting that there is a difference in Total Can do or Cannot Do based on Time to Complete (High or Low) of the participant. See Table 22 for the Overall Chi Square summary. Multiple comparisons revealed for Condition B vs. Time To Complete B; \( \chi^2 (1) = 8.93, \quad < .01 \) was significant. The majority (90%) of the participants who could do the task also took the least amount of time to do it. See Table 26 for a summary of the Chi Square.
### Table 26

**Overall Chi Square analysis of Can Do (DV4) and Time to Complete (IV)**

<table>
<thead>
<tr>
<th>Seconds</th>
<th>Can Do</th>
<th></th>
<th></th>
<th></th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>High vs. Low</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Expected</td>
<td>Observed</td>
<td>Expected</td>
<td>Observed</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>9.5</td>
<td>0</td>
<td>9.5</td>
<td>5</td>
<td>n=5</td>
</tr>
<tr>
<td>1</td>
<td>9.5</td>
<td>7</td>
<td>9.5</td>
<td>7</td>
<td>n=14</td>
</tr>
<tr>
<td>df</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Chi Square</td>
<td>13 overall (df = 1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>7</td>
<td>12</td>
<td>N=19</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note 1: For any missing value a code of 0 was entered because all participants made an attempt to complete the task. All failed attempts were coded as Cannot Do.

Note 2: Data was coded as ABCD Can Do = 1; and ABCD Cannot Do = 0.

0 = Faster Time to Complete; and 1 = Slower Time to Complete
CHAPTER FOUR

DISCUSSION

What is Multimedia?

According to the Merriam-Webster Online dictionary, the term “multimedia” was first used in 1962 to mean using, involving, or encompassing several media. As technology progressed, other definitions followed. In 2005, Tom Antion’s Public Speaking Course website defined Multimedia as “the use of several media, such as movies, slides, music, and lighting in combination normally for the purpose of education or entertainment” (Antion, 2005, p. glossary/Multimedia). In 2008, Computer ServiceNETwork defined multimedia as “the use of a computer to display integrated text, graphics, animation, and sound”. As computers become more sophisticated and less expensive, the potential for use in multimedia presentations such as movies and interactive education increases” (Computer Service NETwork, 2008, p. glossary/Multimedia).

What is Multimedia Learning?

Richard E. Mayer proposed that Multimedia learning is “building mental representations from words and pictures” and that Multimedia Instruction is “presenting words and pictures that are intended to promote learning” (Mayer, 2005, p. 3). Mayer, a professor of Psychology at the University of California in Santa Barbara, defined multimedia learning as learning from both words and pictures. His research in the 1990s (Mayer & Anderson, 1991; Mayer & Gallini, 1990) tested Pavio’s (1971; 1986) theory of dual coding with multimedia instruction. Mayer and his
colleagues found that student scores were significantly better when it came to applying what they had learned after receiving multimedia instruction rather than a single media instruction. Other groups of researchers (Chandler & Sweller, 1991; Chandler & Sweller, 1996; Kalyuga, Ayers, Chandler, & Sweller, 2003; Mayer & Moreno, 1998; Sweller, 1994; Sweller, van Merrienboer, & Pass, 1998) confirmed these results. The experiments usually centered on cause and effect scenarios such as lightning striking (Mayer, Bove, Bryman, Mars, & Tapango, 1996), how brakes work (Mayer, 1989), how pumps work (Mayer & Gallini, 1990), or how a toilet flushes (Mayer, Hegarty, Mayer, & Campbell, 2005). From this growing body of research developed a set of principles of multimedia learning (Mayer, 2005). Those principles drive current research in Multimedia Learning. Today’s Multimedia Learning research adds to our understanding of how people learn from words and pictures in computer-based environments (Mayer, 2005). The current study extended this line of research to include how people learn to complete procedural tasks from words and pictures in computer-based environments.

**How is Multimedia Learning Used in a Graphics Curriculum?**

In the computer graphics classroom, it is common for students to encounter several different formats of information in at least three simultaneously delivered media, (1) text, in book or on the student computer screen or on a document projector screen in the classroom, (2) images, in the textbook or on the student computer screen or on a document projector screen in the classroom, and (3) sounds, emanating from the instructor’s voice, the student’s computer, or the classroom sound and computer projection system. Along with text, images, and sound, the student may interact with several media generators such as a desktop.
computer, monitor, and keyboard, and document projector with audio speakers. The most common student tasks in graphics classes are procedural ones. Students complete projects that require them to reproduce a series of sequenced steps using software programs in order to complete design projects such as re-touching a photo, animating a drawn object, or editing a recorded video.

**Discussion of Dependent Variables**

**Time to Complete.** This Dependent variable was measured in seconds. For all tasks, the shortest completion time for a participant completing a task was observed for Task 3D (Onscreen Narrated Video) at 30 seconds. The longest time for a participant completing a task was observed for Task 2B (Modified Text with Integrated Still Images) at 298 seconds. An Analysis of Variance showed no significant differences in the time it took participants to complete any of the tasks. See Figure 35 for a line graph showing the 19 participant Time to Complete scores for tasks separated by Condition A, B, C, and D. It may be seen in Figure 36 that there were not major time differences across Conditions A, B, C, and D. Further, with a few exceptions, there were not major time differences across Participants. For example, Participant 13 had almost identical Times (approximately 125 seconds) to Complete for Conditions A, C, and D, but Participant 13 used nearly 300 seconds to complete (or fail to complete) the task associated with Condition B.
Time to Complete scores were also coded into a nominal variable and coded as 1 = took more time than the median to do and 0 = took less time than the median to do. This Above vs. Below Median Time to Complete variable was compared to the nominal variable Can Do (A, B, C, D) with a Chi Square. This statistical analysis revealed that there was significance in the overall Chi Square. Multiple comparisons showed that 90% of the participants who completed a task with Condition B (Modified Text with Integrated Still Images) training or Condition D (Onscreen Narrated Video) training completed the task in less than the median time. These findings are similar to findings by Palmiter & Elkerton, 1993, who reported that participants who were trained for procedural tasks with a Demonstration Condition (independent variable) (similar to Condition D in the current study) were faster than other training groups at completing measured tasks. In the present study, Condition B (Modified Text with Integrated Still Images) was found to be as effective as Condition D (Onscreen Narrated Video) in training
participants for faster task completion. The Modified Text with Integrated Still Images (Condition B) may have performed well in this study with regard to time because those materials were designed to conform to the guidelines set forth by Mayer and others in several experiments Mayer & Anderson, 1991; Mayer & Anderson, 1992; Mayer, Moreno, Boire, & Vagge, 1999; and Mayer & Sims, 1994. The materials were designed as Transformational Visuals indicating movement with arrows on static graphics. The materials also exhibited the Temporal Contiguity Principle by having words and pictures placed closely together to decrease the cognitive processing, and they exhibited the Coherence Principle by keeping extraneous materials to a minimum. They also adhered to Visual Communications best practices through the use of (1) the Rule of Thirds, (2) a "Z" Reading Pattern, (3) information chunked into 3-5 piece bits, (4) font selection for readability, (5) color selection for contrast, and (6) ample white space, thus delivering the essential information while limiting the cognitive load.

**Correct Responses.** This Dependent variable was measured in counts and converted to percentages in order to perform statistical analysis. No within-subjects differences were found in the participant Percent Correct scores (A vs. B vs. C vs. D). Percent Correct scores were converted to frequencies above and below the median, and non-parametric tests were computed. The first test crossed Correct Responses (above and below the median) with Prior Knowledge scores (above and below the median). This analysis did not yield a significant difference. The second test crossed Correct Responses (above and below the median) with Spatial Ability (above and below the median). This analysis did not yield a significant difference. The small number of scores available for comparison limited the probability of finding a
significant difference. If the sample had been 75 participants instead of 19, the results may have been different.

**Errors.** This Dependent variable was measured in counts. Because the sequence of the steps in the tasks was of great importance, each mouse click or key stroke that deviated from the prescribed steps was counted as an error. No set limit was established for errors, and some participants made many errors and retraced their steps and went forward again. Some participants with high error counts finished the task, and some did not. No within-subjects differences were found in the participant Error scores (A vs. B vs. C vs. D). Error scores were converted to frequencies above and below the median, and non-parametric tests were computed. The first test crossed Errors (above and below the median) with Prior Knowledge scores (above and below the median). This analysis did not yield a significant difference. The second test crossed Errors (above and below the median) with Spatial Ability (above and below the median). This analysis did not yield a significant difference. The small number of scores available for comparison limited the probability of finding a significant difference.

**Can Do.** This Dependent variable was measured nominally. If the participant finished the task, it was coded 1 = Can Do, and if the participant did not complete the task, it was coded 0 = Cannot Do. The completion rates of the individual Instructional Material Conditions (A, B, C, D) were not significantly different from each other; the completion rate of 79% on the Condition C (Onscreen Modified Text with Silent Onscreen Video) was slightly higher than the other three conditions, but not statistically significant. When the Can Do scores were compared to the participants’ scores on the Prior Knowledge, significance was found. There was a difference in
Can Do or Cannot Do based on the Prior Knowledge of the participant. There were 14 participants (72%) who scored high (above the median) on the Prior Knowledge measure, and who also completed at least one of the measured tasks (A, B, C, D). Multiple comparisons confirmed that when a task was trained with Condition B (Modified Text with Integrated Still Images) the completion rate for that task was higher than for the other training conditions. Participants with a Prior Knowledge score above the median (80%) completed a task trained with the Condition B materials, whereas only 40% of participants with a Prior Knowledge score below the median were able to complete a task trained with the Condition B materials. The difference in Prior Knowledge (high vs. low) must have contributed to the difference in task completion scores, because there was no significant difference in the overall participant completion scores regarding Conditions A, B, C, or D. Prior Knowledge may play a role in effective use of Condition B (Modified Text with Integrated Still Images) training materials.

The Can Do scores were compared with participants’ scores on the Mental Rotations Test to determine if participants’ spatial ability had any effect on being able to complete a task. An overall significance was found. There was a difference in Can Do or Cannot Do based on the Spatial Ability of the participant. Participants who scored high on the Mental Rotations Test (70%) completed at least one of the four measured tasks. Multiple comparisons were used to discern that 90% of the participants who could do the task trained with Condition D (Onscreen Narrated Video) also scored High on the Spatial Ability measure. Only 39% of those participants with low spatial ability scores were able to complete the Condition D task.
Discussion of Research Questions

Research Question 1. Are there are any significant differences in student learning of a computer-based procedural task due to the format of the training materials? Based on the data collected and analyzed in this study, the conclusion would have to be no, there are no differences in learning due to the format of the training materials, but this author suggests that additional similar studies with a larger sample would provide additional information.

Research Question 2. Do individual differences in prior knowledge and spatial abilities make a difference in student learning? Yes, there is evidence of differences in the student learning due to differences in Prior Knowledge and differences in Spatial Ability. High Spatial Ability must aid in some way in understanding or remembering the steps in completing a task because the overall Can Do scores (A vs. B vs. C vs. D) were not significantly different for participants. Since the difference is only found when comparing Condition B with The Mental Rotations Test, Spatial Ability may play a role in effective training employing Modified Text with Integrated Still Images. Possessing prior knowledge of the testing may have contributed to the difference in task completion scores, because there was no significant difference in the overall participant completion scores regarding Conditions A, B, C, or D. Prior knowledge may play a role in effective use of Modified Text with Integrated Still Images training materials.

Recommendations

This author’s recommendations in light of the findings of this study are to continue to investigate multimedia materials for instruction of procedural and computer-based tasks. Mayer, Anderson, Chandler, Sweller and others have built a strong base of knowledge and
theories regarding the increased effectiveness of multimedia materials over single media materials. The four Instructional Material Conditions (A vs. B vs. C vs. D) employed in this study were all classified as multimedia materials, because two or more different media were combined in each condition. Condition A employed text and images, Condition B employed text and enhanced images, Condition C employed text and video, and Condition D employed sound and video. For all four conditions the Percent Correct scores, the Errors, and the Can Do rate were all within expected values. This might mean that as a group of multimedia materials, the differences were slight, but if compared to single media materials they may be significantly different. In many of the Mayer studies, the differences between single media and multimedia materials were studied, and from those studies came a set of Principles of Multimedia Learning.

The advantage of multimedia over single media is well-established by the work of prior researchers. With those principles in place, more studies for testing and comparing multimedia materials could potentially yield more effective ways to match the training medium to the content or to the learner.

The Graphics specialization of Information Design might provide additional insight into development of improved multimedia training materials. Designing larger experiments and varying the time for task testing would be a next logical step to extract more information from the basic constructs put forth in this study. Additional modification of the Condition B (Modified Text with Integrated Still Images) training materials may further reduce cognitive load on the participant. Perhaps the use of more schematic versus real images might be effective, since the research showed some advantage for schematic images over photographic ones. Restructuring
data collection so that the participant does not have to be involved in the video capturing and archiving process would be an improvement. The majority of missing data in this study were missing computer generated video files. Some of the missing files were probably not due to the participant failing to complete the task but rather were due to a mechanical or human error in archiving the video results. Additional research is indicated in spatial ability and pairing different multimedia instructional materials according to spatial ability levels. Additional research is indicated in the role of prior content knowledge and multimedia instructional materials. There may be differences in which multimedia formats are more effective, depending on the prior knowledge level of the participant.

**Limitations of Current Study**

This study encountered several limitations; the greatest was the small number of participants. Original estimates of participation were for 38 enrolled students. On the day of the data collection eight of the 19 enrolled participants attended the first class and 12 of 20 enrolled participants attended the second class. One contributing reason for low attendance may have been that the data collection took place during the last class period before final exams. The collected data were further reduced by instances of missing electronic video files. Some participants were not successful in saving the finished recordings to the computer. Some of those missing files may have contained records of completed tasks.

**Internal and External Validity Issues and Limitations**

The Mental Rotations Test (Vandenberg, 1978) was used to collect Spatial Ability data. Established validity and reliability information was available for the instrument including
administration, scoring, and interpretation guidelines. The Prior Knowledge Test was constructed specifically for this study, and validity had to be established. The 10 questions used were chosen from a bank of final exam questions written by the course instructors for GRAPHICS 2290-Electronic Imaging. The tasks included in the testing were part of the coursework in that class as well. The course textbook provide the basis for the Condition A (Traditional Textbook with Still Images) training materials. After selecting questions that related to the procedures in the instructional materials, a rubric was constructed listing the questions and their applicability to the experiment. Four raters scored the questions on a Likert scale. The rating scale was: 1 = “Does not measure the concept” to 5 “Measures the concept well.” The mean score for the four raters on the total questions on a 5-point scale was 46.5, meaning that there was a 93% agreement among raters and that they judged that the questions were appropriately assessing the assigned topics. Accordingly, content validity was supported.

The scoring of the instructional tasks was a potential inter-rater reliability issue, so three additional scorers were employed to score and code ten percent of the completed tasks. The scorers were selected based on prior knowledge of the topic and then trained with scoring rubrics. Inter-rater reliability was calculated on their scoring during training, and training continued until 90% inter-rater reliability was achieved.

**Measurement Issues**

There were a few measurement issues relating to scoring. Due to the custom nature of the instructional materials, a rubric was developed to use for scoring. It allowed the tasks to be scored in a standardized fashion. Missing data was a measurement issue in that one cannot
analyze what one has not collected. A few participants were not able to save each of their video files to the archive folder, and several pieces of data were missing. Future experiments should look for a solution to this problem. Another measurement issue was the raw scores for the Correct Responses on individual tasks. Because the four tasks were counterbalanced with the four conditions, there were four different versions of each task. The tasks did not have the same number of correct answers possible, so there were 9 possible correct for Task 1 and Task 2 but 11 possible correct for Task 3 and 16 possible correct Task 4. The raw scores could not be used for statistical analysis and each had to be transformed to a percent for analysis. In the future, all counterbalanced tasks should have the same number of possible correct answers.

**Significance of the Investigation**

This research study is innovative because it brings together theories of (1) Multimedia Learning, (2) Cognitive Load, (3) Industrial and Online Training, as well as (4) Principles of Graphics Design in conjunction with training computer-based procedural tasks. Not all forms of instructional materials may be equally effective as training materials for computer-based procedural tasks. Inherent characteristics in the structure of those training materials, or individual differences of the learners may affect the learner’s ability to understand and apply the material. It is established in the literature that student scores are generally higher when applying what they have learned if multimedia materials are employed for instruction than if single media materials are employed.

The current study investigated four forms of multimedia instructional materials; (A) Traditional Textbook with Still Images, (B) Modified Text with Integrated Still Images, (C)
Onscreen Modified Text with Silent Onscreen Video and (D) Onscreen Narrated Video on training a computer-based procedural task. The materials by themselves were not significantly different from each other according to the participant scores. However, by comparing participant scores on those tasks with participant scores on Spatial Ability and Prior Knowledge, the following results were found:

1. Time to complete tasks were faster for participants trained with (B) Modified Text with Integrated Still Images and for participants trained with (D) Onscreen Narrated Video.

2. Participants with High Spatial Ability completed significantly more tasks than participants with Low Spatial Ability.

3. Participants with High Spatial ability completed more tasks trained with (B) Modified Text with Integrated Still Images condition than participants with low Spatial Ability trained with the same condition.

4. Participants with High Spatial ability completed significantly more tasks trained with (D) Onscreen Narrated Video condition than participants with Low Spatial Ability trained with the same condition.

5. Significantly more participants with High Prior Knowledge completed any tasks than Participants with Low Prior Knowledge.

6. Significantly more Participants with High Prior Knowledge completing tasks trained with (B) Modified Text with Integrated Still Images than participants with low Spatial Ability trained with the same condition.
The implication of the differences found in the current study is that Prior Knowledge and Spatial Ability do matter in preparing or selecting multimedia instructional materials to be used for procedural training. These findings are consistent with the literature reviewed. For instance, Mayer and Anderson (1991, 1992) found that participants with High Spatial Ability benefitted from narrated video training, as did participants in the current study. Palmiter & Elkerton, (1993), reported that participants who were trained for procedural tasks with a Demonstration Condition similar to the (D) Onscreen Narrated Video were faster than other participants at completing measured tasks. That finding is consistent with the current study; additionally, the current study found that (B) Modified Text with Integrated Still images condition was equally fast. Participants with High Spatial Ability and participants with High Prior Knowledge may have more cognitive resources with which to process and code the information for condition B and D than participants with Low Spatial Ability and Low Prior Knowledge. A possible training approach might be that learners with high prior knowledge or high spatial ability in the graphics content area may benefit most from either (B) a Modified Text with Integrated Still images or (D) an Onscreen Narrated Video training condition. Each of these two training conditions requires the learner to construct mental representations of the procedural information using minimal information. Learners without the support of pre-existing long-term domain knowledge may benefit more from traditional materials with static or animated and annotated materials because those materials can contain more content support information. It is essential that future research in training procedural tasks (1) identify instructional designs and procedures that support different levels of the learners’ expertise in the content domain,
and (2) that learners be assessed for level of expertise prior to training, so that (3) the appropriate materials for the learner are employed in the training. Future research involving tracking individual participants across individual behaviors might yield descriptions of particular individual effects. Continuous data such as time to complete a task or time to complete a step in a sequence of steps might aid in describing individual effects that might exist.
REFERENCES

Bibliography

(n.d.). Retrieved March 15, 2010, from Flickr.com:
http://images.search.yahoo.com/images/view?back=http%3A%2F%2Fimages.search.yahoo.com%2Fsearch%2Fimages%3Fp%3Dvintage%2Bart%2Bposters%26js%3D1%26b%3D1%26ni%3D20%26ei%3Dutf-8%26vm%3Dr%26xargs%3D0%26pstart%3D1&w=319&h=500&imgurl=farm1.static.flickr.com%2F24%2F3%


Miller, G. (1956). The magic number seven, plus or minus two: Some limits on our capacity for processing information. *Psychological Review, 63*.


Instructor's Permission to Conduct Research in Class
Tuesday, April 07, 2009

To Whom It May Concern:

Kari Carlson Coffindaffer has my permission to recruit participants and collect data for her study in my classes: GRAP 1150-01 and GRAP 1150-02.

TITLE:
Test, Graphics, and Multimedia Materials Employed in Learning a Computer Based Procedural Task

PRINCIPAL INVESTIGATOR:
Dr. Richard T. Wals, Ph. D.

CO INVESTIGATOR:
Kari Carlson Coffindaffer, M.F.A.

LOCATION OF DATA COLLECTION:
Data will be collected during class
Graphics 1150 Section 01 and Graphics 1150 Section 02
In RM ET 432 Engineering Technology Building
Pierpont Community and Technical College
Fairmont State University
1201 Locust Avenue, Fairmont, WV 26554

COURSE INSTRUCTOR:
Shelby L. Solberg, BA

PARTICIPANT RECRUITMENT:
A verbal script will be read by the instructor in class to recruit participants.

Shelby L. Solberg
Course Instructor, Pierpont C&TC
Vue Fine Art & Design
Appendix B

West Virginia University IRB Approval and Fairmont State University / Pierpont Community and Technical College IRB Approval
Expedited-IRB Protocol-Approval

To:       Wells, Richard
From:     WVU Office of Research Compliance
Date:     Monday, April 27, 2009
Subject:  Approval Letter

Tracking #: H-21541
Title:     Text, Graphics, and Multimedia Materials Employed in Learning a Computer-Based Procedural Task

The research study referenced above was reviewed by the West Virginia University Institutional Review Board (IRB) via expedited review procedures and was approved in accordance with 46 CFR 46.101(b)7.

This protocol was reviewed using the following:

  Regulatory Criteria Checklist (210q)
  Expedited Review Checklist (210a)
  Advertisement Checklist (210i)
  Informed Consent - Only Minimal Risk Checklist (210z)

  Category 7

The following documents have been approved and validated for use in this study and are available in the BRAAN system:

  In-Class Recruitment Script
  Consent Form

Thank you.
Once you begin your human subject research, the following regulations apply:

1. Unanticipated or serious adverse events/side effects encountered in this research study must be reported to the IRB within five (5) days.
2. Any modifications to the study protocol or informed consent form must be reviewed and approved by the IRB prior to implementation.
3. You may not use a modified informed consent form until it has been approved and validated by the IRB.
This is sufficient for data collection on this campus.

Dr. Clarence C. Rohrbaugh  
Chair, Department of Behavioral Sciences  
110E Hardway Bldg.  
304-367-4669

From: Coffindaffer, Kari  
Sent: Monday, April 27, 2009 4:59 PM  
To: Rohrbaugh, Clarence  
Subject: RE: IRB Question

Clarence,

I have obtained WVU IRB approval today for my Dissertation study. I am attaching the Approval memo and the Protocol. I know it is a rush but I would like to collect data on May 4th so that I can write the results for my dissertation over the summer.

Kari

From: Rohrbaugh, Clarence  
Sent: Monday, February 23, 2009 9:57 AM  
To: Coffindaffer, Kari  
Subject: RE: IRB Question

Kari

A copy of the WVU approval is sufficient for our records.

Dr. Clarence C. Rohrbaugh  
Chair, Department of Behavioral Sciences  
110E Hardway Bldg.  
304-367-4669

From: Coffindaffer, Kari  
Sent: Friday, February 20, 2009 5:08 PM  
To: Rohrbaugh, Clarence  
Subject: IRB Question

Clarence,

I have submitted an IRB research application to WVU for my dissertation research in Educational Psychology. I intend to recruit FSUPCTC students in a graphics class. Do I have to submit a separate IRB on the FS form or can I submit the WVU application to your committee? I am attaching the WVU materials printed out as a pdf from their online system.

Just let me know what I should do next.

Thanks,
Kari

Kari C. Coffindaffer, MFA
Kari Carlson Coffindaffer, MFA
BS Program Coordinator, Graphics Technology
Fairmont State University / Pierpoint Community and Technical College
409 Engineering Technology Building
1201 Locust Avenue
Fairmont, WV 26554

Office Phone: 304-367-4638
e-mail: Kari.Coffindaffer@fairmontstate.edu
e-mail: Kari.Coffindaffer@pierpont.edu
Appendix C

Participant Recruitment Script
You are invited to take part in an educational research study. This study is being conducted by Kari Carlson Coffinseffer in the Department of Technology, Learning, and Culture, in the College of Human Resources and Education at West Virginia University. This research is being conducted to fulfill the requirements for a doctoral dissertation in Educational Psychology in the Department of Technology, Learning & Culture at West Virginia University, under the supervision of Dr. Richard T. Walls, Ph.D.

The purpose of this study is to examine how graphic design students interact with different forms of software training material. WVU expects to enroll approximately 36 subjects; a total of approximately 36 subjects at all sites are expected to participate in this study. You must be 18 years of age to participate in this study.

**Description of Procedures**
This study involves six short tasks. You will be tested on Prior Knowledge and Spatial Ability and four computer learning tasks. The study will take approximately 70 minutes for you to complete. You will be asked to take a 10-question Spatial Ability test. This will take approximately 10 minutes. You will be asked to answer a 10-question Prior Knowledge questionnaire. This will take approximately 10 minutes. You will then be asked to review and practice four different computer-based software procedural tasks and take a 5-minute skills test on each of the 4-procedures. Screen capture software will be used to record your on-screen mouse movements for each of the four tasks. This portion of the study will take 48 minutes. You do not have to answer all the questions. You will have the opportunity to see the questionnaires before signing this consent form.

**Risks and Discomforts**
There are no known or expected risks from participating in this study, except for the mild frustration associated with answering the questions, and performing the procedural (software) tasks.

**Benefits**
You may or may not receive any direct benefit from this study. You may learn some computer-based procedural tasks that could benefit you in your future graphic software courses. The knowledge gained from this study may eventually benefit others.

**Financial Considerations**
You will not incur any costs to you as a result of participation in the study.

**Confidentiality**
Any information about you that is obtained as a result of your participation in this research will be kept as confidential as legally possible. In any publications that result from this research, neither your name nor any information from which you might be identified will be published without your consent.
Appendix D

Voluntary Consent Form
CONSENT AND INFORMATION FORM

Computer-Based Procedural Task

Principal Investigator: Walls, Richard
Department: HUMAN RESOURCES & EDUCATION - Technology.
Tracking Number: Learning, and Culture (TLC)
H-21541

Study Title:
Text, Graphics, and Multimedia Materials Employed in Learning a Computer
-Based Procedural Task

Co-Investigator(s):
Carlson Coffindaffer, Kari,

Sponsor

Contact Persons
In the event you experience any side effects or injury related to this
research, you should contact Kari Carlson Coffindaffer at 304/367-4638.
(After hours contact Kari Carlson Coffindaffer at 304/745-3192.)
If you have any questions, concerns, or complaints about this research,
you can contact Kari Carlson Coffindaffer at 304/367-4638

For information regarding your rights as a research subject, you may contact the Office of
Research Compliance at 304/293-7073.

Introduction
You, ____________________________, have been asked to participate in this
research study, which has been explained to you by Kari Carlson
Coffindaffer, M.F.A. This study is being conducted by Kari Carlson
Appendix D

Coffindaffer in the Department of Technology, Learning, and Culture in the College of Human Resources and Education at West Virginia University. This research is being conducted to fulfill the requirements for a doctoral dissertation in Educational Psychology in the Department of Technology, Learning & Culture at West Virginia University, under the supervision of Dr. Richard T. Walls, Ph.D.

**Purposes of the Study**

The purpose of this study is to examine how graphic design students interact with different forms of software training materials. WVU expects to enroll approximately 36 subjects; a total of approximately 36 subjects at all sites are expected to participate in this study.

**Description of Procedures**

This study involves six short tasks. You will be tested on Prior Knowledge and Spatial Ability and four learning tasks. You will be trained and tested on each of 4 computer tasks. The form of the instructional materials will be counterbalanced so that you will experience a different form of instructional material for each of your tasks. The study will take approximately 70 minutes for you to complete. You will be asked to take a 10-question Spatial Ability test. This will take approximately 10 minutes. You will be asked to answer a 10-question Prior Knowledge questionnaire. This will take approximately 10 minutes. You will then be asked to review and practice 4 different computer-based software procedural tasks and take a 5-minute skills test on each of the 4 procedures. Screen capture software will be used to record your onscreen mouse movements for each of the four tasks. This portion of the study will take 48 minutes. You do not have to answer all the questions. You will have the opportunity to see the questionnaires before signing this consent form.

**Risks and Discomforts**

There are no known or expected risks from participating in this study, except for the mild frustration associated with answering the questions, and performing the procedural (software) tasks.

**Alternatives**

<table>
<thead>
<tr>
<th>Tracking #:</th>
<th>H-21541</th>
<th>Page: 2 of 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approved On:</td>
<td>04/27/2009</td>
<td></td>
</tr>
<tr>
<td>Valid Through:</td>
<td>04/26/2010</td>
<td></td>
</tr>
<tr>
<td>Last Amended:</td>
<td>N/A</td>
<td></td>
</tr>
</tbody>
</table>
You do not have to participate in this study.

There are no alternate forms of participation for this study.

**Benefits**
You may or may not receive any direct benefit from this study. You may learn some computer-based procedural tasks that could benefit you in your future graphics software courses. The knowledge gained from this study may eventually benefit others.

**Financial Considerations**
You will not incur any costs to you as a result of participation in the study.

**Confidentiality**
Any information about you that is obtained as a result of your participation in this research will be kept as confidential as legally possible. Your research records and test results, just like hospital records, may be subpoenaed by court order or may be inspected by federal regulatory authorities without your additional consent. In any publications that result from this research, neither your name nor any information from which you might be identified will be published without your consent.

**Voluntary Participation**
Participation in this study is voluntary. You must be 18 years of age to participate in the study. You are free to withdraw your consent to participate in this study at any time. Refusal to participate or withdrawal will not affect your class standing or grades, as appropriate and will involve no penalty to you. In the event new information becomes available that may affect your willingness to participate in this study, this information will be given to you so that you can make an informed decision about whether or not to continue your participation. You have been given the opportunity to ask questions about the research, and you have received answers concerning areas you did not understand.
Tracking #: H-21541

Upon signing this form, you will receive a copy.

I willingly consent to participate in this research.

Signature of Subject or Subjects Legal Representative
Printed Name
Date
Time

The participant has had the opportunity to have questions addressed. The participant willingly agrees to be in the study.

Signature of Investigator or Co-Investigator
Printed Name
Date
Time

Tracking #: H-21541
Approved On: 04/27/2009
Valid Through: 04/26/2010
Last Amended: N/A

Page 4 of 4

Initials Date
Appendix E

Helper Training Sheet
**Helper Instructions:**

*These instructions are to supplement your verbal training session.*

**TITLE OF STUDY:**

Text, Graphics, and Multimedia Materials Employed in Learning a Computer Based Procedural Task

**PRINCIPAL INVESTIGATOR:**

Dr. Richard T. Walls, Ph. D.

**CO INVESTIGATOR:**

Kari Carlson Coffindaffer, M.F.A.

**LOCATION OF DATA COLLECTION:**

Data will be collected during class:
- Graphics 1150 Section 01
- Graphics 1150 Section 02
- In room 432 Engineering Technology Building
- Pierpont Community and Technical College and Fairmont State University
- 1201 Locust Avenue, Fairmont, WV 26554

**COURSE INSTRUCTOR:**

Shelly L. Solberg, BA

This study is being conducted by Kari Carlson Coffindaffer in the Department of Technology, Learning, and Culture, in the College of Human Resources and Education at West Virginia University. This research is being conducted to fulfill the requirements for a doctoral dissertation in Educational Psychology in the Department of Technology, Learning & Culture at West Virginia University, under the supervision of Dr. Richard T. Walls, Ph.D.

**The purpose of this study** is to examine how graphic design students interact with different forms of software training materials. There will be a total of approximately 36 subjects participating in this study. Participants must be 18 years of age to participate in this study.

**Description of Procedures**

- At the beginning of each session the investigator will introduce all helpers and read the recruitment script aloud.
- Non-participating individuals will be asked to leave.
- Remaining participants will fill out and sign the informed consent. Helpers will assist in distributing and collecting the consent forms. Completed consent forms are to be placed in a single stack on the side counter.
- The first assessment is the MRT and the numbered packets are already collated and stacked for distribution. The numbered MRT packets will be distributed to the matching numbered computer stations. A corresponding number is already attached to the computer monitor for each session.
- After the MRT is completed helpers will make sure the packets are numbered and collect the packets and stack them in a single stack on the side counter.
- The Photoshop Pretest will be given next. The helpers will distribute and collect it in the same manner as the MRT, placing the packets in a third stack on the side counter.
- The packets for the Procedural Tasks are numbered and collated as well and will be distributed and collected in the same manner. Participant numbers must remain consistent through the data collection.
- This study involves six short tasks. The study will take approximately 70 minutes for participants to complete. Helpers will stand by to troubleshoot any and all technical difficulties that impede the data collection. It is anticipated that you might have to help a participant locate files on the desktop or make sure that the recording function is operating, or assist in hooking up the earphones to the computer. You will also maintain the integrity of the testing environment, making sure participants work alone and adhere to the established start and end times of the assessments. At no time will you coach a participant in the task being assessed.
- At the end of a session all materials for that session will be boxed and placed in the investigator's office.
- Helpers will organize and set up for the next session.
Appendix F

Mental Rotations Test Booklet
MRT Part 1 Booklet | 3.5 Minutes

MRT

Part One

Participant Number: ________________

Score: ________________
This is a test of your ability to look at a drawing of a given object and find the same object within a set of dissimilar objects. The only difference between the original object and the chosen object will be that they are presented at different angles. An illustration of this principle is given below, where the same single object is given in five different positions. Look at each of them to satisfy yourself that they are only presented at different angles from one another.

Below are two drawings of new objects. They cannot be made to match the above five drawings. Please note that you may not turn over the objects. Satisfy yourself that they are different from the above.

Now let's do some sample problems. For each problem there is a primary object on the far left. You are to determine which two of four objects to the right are the same object given on the far left. In each problem always two of the four drawings are the same object as the one on the left. You are to put Xs in the boxes below the correct ones, and leave the incorrect ones blank. The first sample problem is done for you.

Go to the next page

Adapted by S.G. Vandenberg, University of Colorado, July 15, 1971
Revised instructions by H. Crawford, U. of Wyoming, September, 1979
Do the rest of the sample problems yourself. Which two drawings of the four
on the right show the same object as the one on the left? There are always
two and only two correct answers for each problem. Put an X under the two
correct drawings.

Answers: (1) first and second drawings are correct
(2) first and third drawings are correct
(3) second and third drawings are correct

This test has two parts. You will have 3 minutes for each of the two parts.
Each part has two pages. When you have finished Part 1, STOP. Please do not
go one to Part 2 until you are asked to do so. Remember: There are always
two and only two correct answers for each item.

Work as quickly as you can without sacrificing accuracy. Your score on this
test will reflect both the correct and incorrect responses. Therefore, it
will not be to your advantage to guess unless you have some idea which
choice is correct.

DO NOT TURN THIS PAGE UNTIL ASKED TO DO SO
MRT Part 1 Booklet  3.5 Minutes

DO NOT TURN THIS PAGE UNTIL ASKED TO DO SO.  STOP
Appendix G

Prior Knowledge Test Booklet
PRETEST

Participant Number: ______________

Score: ______________
PRETEST OF PRIOR PHOTOSHOP KNOWLEDGE:

Instructions:

Please attempt ALL questions. Each question includes several optional statements or answers; you should select the one most appropriate answer. Circle the option letter of your selected answer on the question paper.

1. Which drop-down menu contains the Shadows and Highlights adjustment?
   a. File
   b. Edit
   c. Image
   d. Layer
   e. Select
   f. Filter
   g. Analysis
   h. View
   i. Window

2. What tool do you use to straighten an image?
   a. Move
   b. Rectangular Marquee
   c. Magic Wand
   d. Crop
   e. Path Selection
   f. Rectangle
   g. Slice

3. What is the value of the Shadows adjustment point in the following histogram?
   a. 0
   b. 1.0
   c. 255
4. Please circle the icon that represents the crop tool.

5. Please circle the location of the healing brush.

6. What information can you deduce from this histogram?
   a. The image is too light
   b. The image is too dark.
   c. The image levels have been adjusted.
   d. The image levels need to be adjusted.
7. Which tool would you use to retouch this stone photo?
   a. Clone Stamp tool
   b. Spot Healing Brush
   c. Healing Brush
   d. History Brush

8. What can you do with the Crop tool?
   a. Add space around an image
   b. Straighten an image
   c. None of the above
   d. Both of the above

9. By default, how many items are recorded in the History pallet?
   a. 20
   b. 40
   c. 100
   d. Unlimited

10. What tool do you use to remove a color cast from an image?
    a. Saturation
    b. Auto Levels
    c. Hue and Saturation
    d. Auto Color Correction
Appendix H

Testing Materials for Task 1 (A, B, C, D)
TASK ONE-A-Booklet | 7 Minutes

TASK ONE A

Participant Number: _____________

Score: ________________
TRAINING: 7 minutes

1. Please open the software Photoshop.
2. Please open the Task1_Training Image from your numbered folder on the desktop.
3. Perform the procedure described below beginning with STEP 3:
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

This masked area is not part of the current training. Please continue with Step 3.

3 Choose Image > Adjustments > Auto Color.

4 Choose Image > Adjustments > Shadow/Highlight.
5. In the Shadow/Highlight dialog box, drag the Highlight and Shadow sliders as needed until you think the image looks good. Make sure that Preview is checked so that you can see the changes applied to the image window as you work.

6. Click OK to close the dialog box, and then choose File > Save.

Reminder: Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task1_Test Image from your numbered folder on the desktop.
6. Perform the Automatic Adjustments Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

10. The recording will now be saved in your numbered desktop folder.
TASK ONE

Participant Number: _______________

Score: _______________
TRAINING: 7 Minutes

1. From Photoshop, please open the TaskL_Training image that is in your numbered folder on the desktop.

2. Perform the procedure described below:

3. Save the completed file to your numbered folder on the desktop. Do not change the file name.

To brighten the colors in an image:

1. Choose Image
2. Choose Adjustments
3. Choose Auto Color

To adjust the highlights and shadows in an image:

1. Choose Image
2. Choose Adjustments
3. Choose Shadows / Highlights
In the Shadow/Highlight dialog box:

1. Checkmark Preview so you can see the changes as you work
2. Move the sliders to improve the look of the image
3. Click OK

Reminder: This process saves the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis.
Use these key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task1_Test Image from your numbered folder on the desktop.
6. Perform the Automatic Adjustments Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
TASK ONE-C

Participant Number: _______________

Score: _______________
TASK ONE-C-Booklet | 7 Minutes

TRAINING: 7 Minutes

Please watch the Task1C_Silent_Training_Video. You can play the video by clicking on the Task1C_Silent_Training_Video in your numbered folder on the desktop. You may replay the video. You may practice the training task by doing the following:

1. Please open the software Photoshop.
2. Please open the Task1_Training Image from your numbered folder on the desktop.
3. Perform the procedure depicted in the video.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TASK ONE-C-Booklet | 5 Minutes

TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/I).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task1_Test Image from your numbered folder on the desktop.
6. Perform the Automatic Adjustments Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
TASK ONE

Participant Number: ________________

Score: ________________
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the "Capture Video" icon to start the recording.

5. From Photoshop, open the Task1_Test Image from your numbered folder on the desktop.
6. Perform the Automatic Adjustments Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
Appendix I

Testing Materials for Task 2 (A, B, C, D)
TASK TWO

Participant Number: ________________

Score: ________________
TRAINING: 7 minutes

1. Please open the software Photoshop.
2. Please open the Task2_Training Image from your numbered folder on the desktop.
3. Perform the procedure described below.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

This masked area is not part of the current training please continue with Step 1

1 In the toolbox, select the Crop tool (%). Then, in the tool options bar (at the top of the work area), enter the dimensions (in inches) of the finished image: For Width type 2 in, and for Height type 3 in.
5 Place the pointer inside the crop marquee, and drag the marquee until it contains all the parts of the picture you want shown to produce an artistically pleasing result. If you need to adjust the size of the marquee, drag one of the corner handles. You can also press the arrow keys to adjust the marquee in 1-pixel increments.

6 Press Enter or Return. The image is now cropped, and the cropped image now fills the image window, straightened, sized, and cropped according to your specifications.

Reminder: Save the completed file to your numbered folder on the desktop.
Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task2_Test image from your numbered folder on the desktop.
6. Perform the Straightening and Cropping Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
TASK TWO

Participant Number: ________________

Score: ________________
TRAINING: 7 Minutes

1. From Photoshop, please open the Task2_Training Image from your numbered folder on the desktop.

2. Perform the procedure described below:

3. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Making the Selection:

1. Select the Crop Tool

2. Click and drag a narrow box around the image.
Adjust the Selection:

1. Rotate the marquee from the handle to match the angle of the image

2. Match size of image by dragging the marquee in from ALL sides

3. Press Enter on the Keyboard to Crop the Image

4. Choose File>Save

Reminder: Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task2_Tests image from your numbered folder on the desktop.
6. Perform the Straightening and Cropping Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
Appendix I

TASK TWO-C-Booklet | 7 Minutes

TASK TWO

C

Participant Number: ________________

Score: ________________
TRAINING: 7 Minutes

Please watch the Task2C_Silent_Training_Video. You can play the video by clicking on the Task2C_Silent_Training_Video in your numbered folder on the desktop. You may replay the video. You may practice the training task by doing the following:

1. Please open the software Photoshop.
2. Please open the Task2_Training Image from your numbered folder on the desktop.
3. Perform the procedure depicted in the video. You do not need to save the file.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording:

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the "Capture Video" icon to start the recording.

5. From Photoshop, open the Task2_Test Image from your numbered folder on the desktop.
6. Perform the Straightening and Cropping Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
TASK TWO-D-Booklet  |  7 Minutes

TASK TWO

D

Participant Number: _______________
Score: _______________
TRAINING: 7 Minutes

Please use the ear buds / headphones provided when viewing the Task2D_Narrated_Training_Video. You can play the video by clicking on the Task2D_Narrated_Training_Video in your numbered folder on the desktop. You may replay the video. You may practice the training task by doing the following:

1. Please open the software Photoshop.
2. Please open the Task2_Training Image from your numbered folder on the desktop.
3. Perform the procedure depicted in the video.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn gray to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task2_Test Image from your numbered folder on the desktop.
6. Perform the Straightening and Cropping Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
Appendix J

Testing Materials for Task 3 (A, B, C, D)
TASK THREE

A

Participant Number: ________________

Score: ________________
TRAINING: 7 Minutes

1. Please open the software Photoshop.
2. Please open the Task3_Training Image from your numbered folder on the desktop.
3. Perform the procedure described below.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

![Image of Adobe Photoshop with histogram and levels settings]

1. Choose Window > Histogram, or click the Histogram tab in the Navigator palette group to make the Histogram palette visible. Click the arrow in the upper right corner to display the palette menu. Then choose Expanded View from the Histogram palette menu.

2. Choose Image > Adjustments > Levels to open the Levels dialog box.
3. Make sure that the Preview check box is selected, and then move the dialog box, if necessary, so that you can also see the image window and Histogram palette.

   The left (black) triangle below the histogram represents the shadows, the middle (gray) triangle represents the midtones, or gamma, and the right (white) triangle represents the highlights. If your image had colors across the entire brightness range, the graph would extend across the full width of the histogram. Notice that at this point, the graphs in the Levels dialog box and the Histogram palette are identical.
Appendix J

68 | LESSON 2
Basic Photo Corrections

4 In the Levels dialog box, drag the left triangle to the right to the point where the histogram indicates that the darkest colors begin. As you drag, the first Input Levels value (above the histogram graph) changes and so does the image itself. In the Histogram palette, the left portion of the graph now stretches to the edge of the frame. This indicates that the darkest shadow values have shifted closer to black.

5 Drag the right triangle to the left to the point where the histogram indicates that the lightest colors begin. Again, notice the changes in the third Input Levels value, in the image itself, and in the Histogram palette graph.

6 Drag the middle triangle a short distance to the left side to lighten the midtones.

Do not turn this page until asked to do so.
Watch the changes in the image window and in the Histogram palette graph to determine how far to drag the middle triangle.

7 When the image looks good to you (we used Input Levels values of 25, 1.20, and 197), click OK to apply the changes. Then save your work.

Reminder: Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the "Capture Video" icon to start the recording.

5. From Photoshop, open the Task3_Test image from your numbered folder on the desktop.
6. Perform the Tonal Range Adjustment Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

10. The recording will now be saved in your numbered desktop folder.
TASK THREE
B

Participant Number: ______________
Score: ______________
TRAINING: 7 Minutes

1. From Photoshop, please open the Task3_Training image that is in your numbered folder on the desktop.

2. Perform the procedure described below:

3. Save the completed file to your numbered folder on the desktop. Do not change the file name.

To see the Levels Histogram:
   1. Choose Window
   2. Choose Histogram

The Histogram window will open next to the image:
**Open the Levels Dialog box:**

1. Choose Image
2. Choose Adjustments
3. Choose Levels

4. The Levels Dialog Box will open.

5. Make sure the Preview check box is selected, and then, move the dialog box, if necessary, so that you can also see the Image window and the Histogram Window.
The Levels Dialog box shows you a graphic display of the shadows, midtones and highlights of the image. You can adjust the tonal range using the triangle shaped sliders.

To adjust tonal range:
1. Drag the shadow slider in to the slope
2. Drag the Highlight slider into the slope
3. Drag the midtones slightly to toward the shadows
TASK THREE-B-Booklet | 7 Minutes

Compare the Levels Dialog Box and the Histogram Window:

1. The Histogram Window will show both the previous levels and the current ones as overlaid images.
2. The Levels Dialog box shows only the current levels.

When you are satisfied with the tonal adjustment save your work.

Reminder: Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task3_Test Image from your numbered folder on the desktop.
6. Perform the Tonal Range Adjustment Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
TASK THREE

Participant Number: ______________

Score: ______________
TRAINING: 7 Minutes

Please watch the Task3C_Silent_Training_Video. You can play the video by clicking on the Task3C_Silent_Training_Video in your numbered folder on the desktop. You may replay the video. You may practice the training task by doing the following:

1. Please open the software Photoshop.
2. Please open the Task3_Training Image from your numbered folder on the desktop.
3. Perform the procedure depicted in the video.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis.
Use the following key commands to start the screen recording:

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task3_Test Image from your numbered folder on the desktop.
6. Perform the Tonal Range Adjustment Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
TASK THREE

D

Participant Number: ________________

Score: ________________
TRAINING: 7 Minutes

Please use the ear buds / headphones provided when viewing the
Task3D_Narrated_Training_Video. You can play the video by clicking on the
Task3D_Narrated_Training_Video in your numbered folder on the desktop. You may replay
the video. You may practice the training task by doing the following:

1. Please open the software Photoshop.
2. Please open the Task3_Training Image from your numbered folder on the desktop.
3. Perform the procedure depicted in the video.
4. Save the completed file to your numbered folder on the desktop. Do not change the
file name.

Do not turn this page until asked to do so.
Appendix J

TASK THREE-D-Booklet 5 Minutes

TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task3_Test image from your numbered folder on the desktop.
6. Perform the Tonal Range Adjustment Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
Appendix K

Testing Materials for Task 4 (A, B, C, D)
TASK FOUR-A-Booklet | 7 Minutes

TASK FOUR

A

Participant Number: ________________
Score: ________________
TRAINING: 7 Minutes

1. Please open the software Photoshop.
2. Please open the Task4_Training Image from your numbered folder on the desktop.
3. Perform the procedure described below.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Using the Healing Brush to remove flaws
Your first goal for this image is to remove the initials that mar the natural beauty of the rock wall.

This masked area is not part of the current training please continue

3. In Photoshop, select the Zoom tool (%) in the toolbox. Click the initials "DJ" that have been scratched into the lower left area of the rock so that you see that area of the image at about 200%.
4. In the toolbox, select the Healing Brush tool (.), hidden under the Spot Healing Brush tool.
5. In the tool options bar, open the Brush Preset pop-up palette, and decrease the Diameter value to 10 pixels. Then, close the pop-up palette and make sure that the other settings in the tool options bar are set to the default values: Normal in the Mode option, Sampled in the Source option, and the Sample Aligned check box deselected.
6 Hold down Alt (Windows) or Option (Mac OS) and click just above the scratched-in graffiti in the image to sample that part of the rock. Then release the Alt/Option key.

7 Starting above the graffiti “D,” paint straight down over the top part of the letter, using a short stroke.
Notice that as you paint, the area the brush covers temporarily looks as if it isn’t making a good color match with the underlying image. However, when you release the mouse button, the brush stroke blends in nicely with the rest of the rock surface.

8 Continue using short strokes to paint over the graffiti, starting at the top and moving down until you can no longer detect the graffiti letters.
When you finish removing the graffiti, look closely at the surface of the rock, and notice that even the subtle striations in the stone appear to be fully restored and natural-looking in the image.

9. Zoom out to 100%, and choose File > Save.

Reminder: Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task4_Test Image from your numbered folder on the desktop.
6. Perform the Healing Brush Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

10. The recording will now be saved in your numbered desktop folder.
TASK FOUR

B

Participant Number: ________________
Score: ________________
TRAINING: 7 Minutes

1. From Photoshop, please open the Task4_Training image that is in your numbered folder on the desktop.

2. Perform the procedure described below:

3. Save the completed file to your numbered folder on the desktop. Do not change the file name.

To remove the graffiti in the image:

1. Select the Zoom tool
2. Click on the Graffiti to enlarge
3. 200% enlargement is adequate

To begin editing:

1. Select the Healing Brush hidden under the Spot Healing Brush.
Set the Tool Options:

1. Set these values:
   a. Brush size = 10 pixels
   b. Mode = Normal
   c. Source Option = Sampled
   d. Sample Aligned = NOT checked
Use the Healing Tool:

1. Hold down the Option key (Mac) and click near the graffiti to sample an undamaged section of the rock.

2. Release the Alt key

3. Paint over the graffiti using short downward strokes.

The brush covers the graffiti with strokes that blend in with the rest of the rock.

4. When you are satisfied with the repair save the file.

Reminder: Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn gray to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task4_Test Image from your numbered folder on the desktop.
6. Perform the Healing Brush Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

10. The recording will now be saved in your numbered desktop folder.
TASK FOUR

Participant Number: ________________

Score: ________________
TRAINING: 7 Minutes

Please watch the Task4C_Silent_Training_Video. You can play the video by clicking on the Task3C_Silent_Training_Video in your numbered folder on the desktop. You may replay the video. You may practice the training task by doing the following:

1. Please open the software Photoshop.
2. Please open the Task4_Training Image from your numbered folder on the desktop.
3. Perform the procedure depicted in the video.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis. Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task4_Test Image from your numbered folder on the desktop.
6. Perform the Healing Brush Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

10. The recording will now be saved in your numbered desktop folder.
TASK FOUR

D

Participant Number: _______________

Score: _______________
TRAINING: 7 Minutes

Please use the ear buds / headphones provided when viewing the Task4D_Narrated_Training_Video. You can play the video by clicking on the Task4D_Narrated_Training_Video in your numbered folder on the desktop. You may replay the video. You may practice the training task by doing the following:

1. Please open the software Photoshop.
2. Please open the Task4_Training Image from your numbered folder on the desktop.
3. Perform the procedure depicted in the video.
4. Save the completed file to your numbered folder on the desktop. Do not change the file name.

Do not turn this page until asked to do so.
TEST: 5 Minutes

Your onscreen actions for this test section will be recorded for later analysis.
Use the following key commands to start the screen recording.

1. Please start the recording now using the key commands (Shift/Command/1).
2. The mouse will turn into crosshairs. Click and drag the crosshairs from the upper right corner of the screen to the lower left corner and release the click. You should select the entire screen.
3. The screen will turn grey to indicate that the area will be recorded.
4. A dialog box will open. Click on the “Capture Video” icon to start the recording.

5. From Photoshop, open the Task4_Test Image from your numbered folder on the desktop.
6. Perform the Healing Brush Procedure to the image without looking back at the training materials.
7. Save the completed Photoshop file to your numbered folder on the desktop. Do not change the file name.
8. Stop the screen recording now by clicking on the stop capture button:

9. Save the capture to your numbered desktop folder by clicking on the save button programmed with your Participant Number.

The recording will now be saved in your numbered desktop folder.
Appendix L

Inter-rater Reliability Training Materials
Summary of Scores:

File Name: 2009-05-04-1143

DV 1. Time to Complete: 0:01:55.21
*Total minutes and seconds displayed at the last frame of the video capture

DV 2. Correct Responses: ____________
* Total points column 3 of rubric

DV 3. Errors: _______________________
*Total error clicks column 2 of rubric

DV 4. Can Do: Yes
*Did the student ultimately complete the adjustment?

<table>
<thead>
<tr>
<th></th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>☑</td>
<td></td>
</tr>
</tbody>
</table>
## Task Four Scoring Rubric

**Evaluator:** [Name]  
**Participant Number:** 1A  
**Condition:** 1A

### Correct Responses:
*Use the following rubric to calculate the correct responses. (total points column 3)*

### Errors:
*(total of number of error clicks from column 3)*

<table>
<thead>
<tr>
<th>Response</th>
<th>Completed</th>
<th>Check No or Yes</th>
<th>Points</th>
<th>Time Stamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open Photoshop</td>
<td>✔ Yes ☐ No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. clicked on Photoshop icon in Dock to open Program.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test Image file and chose “open with Photoshop” from list.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1 If no: how many error clicks before resuming at step 1?</td>
<td></td>
<td>number of error clicks? 0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Open Task 1 Test Image</td>
<td>✔ Yes ☐ No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. from Photoshop: clicked on “OPEN FILE” and navigated to Task 1 Test image</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test Image file and chose “open with Photoshop” from list in Step 1.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Task Four Scoring Rubric
Evaluator: [Name]
Condition: [Condition]
Participant Number: [Number]

If the participant deviates from the scripted instructions:
Check NO, and describe what actions were taken instead.
If the participant clicked around and later completed the step then cross out the NO and check YES and use the time stamp for the correct click action.

<table>
<thead>
<tr>
<th>Step Description</th>
<th>Yes</th>
<th>No</th>
<th>Time of &quot;click&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Image&gt; Adjustment&gt; Autocolor</td>
<td>☑</td>
<td>✗</td>
<td>:00:00.00</td>
</tr>
</tbody>
</table>
| 3.1 If no: how many error clicks before resuming at step 3? | | | | number of error clicks: 2

NOTE:
- Closed warning box
- Resumed @ 3.
<table>
<thead>
<tr>
<th>Task Four Scoring Rubric</th>
<th>Participant Number</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evaluator:</td>
<td>101</td>
<td>IA</td>
</tr>
<tr>
<td>4. Set slider values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ Yes</td>
<td>□ No</td>
<td>1</td>
</tr>
<tr>
<td>4.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ a. highlight final value:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ b. shadow final value:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Which slider was adjusted first?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ a. highlight</td>
<td></td>
<td></td>
</tr>
<tr>
<td>│</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ b. shadow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Is Preview checked in the dialog box?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ a. yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ b. no</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ c. no, clicked to check it</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of &quot;click&quot;:</td>
<td>0:01:28:07</td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clicked OK to accept adjustment?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ a. yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>□ b. no</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔ c. no, clicked to check it</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of &quot;click&quot;:</td>
<td>0:01:28:18</td>
<td></td>
</tr>
<tr>
<td>5.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If no: how many error clicks before resuming at step 5?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>number of error clicks:</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>NOTE:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Task Four Scoring Rubric
Evaluator: KCC
Condition: 1A

At the end of each test the participant is instructed to save the file and may do that in several ways.

<table>
<thead>
<tr>
<th>6. Save file</th>
<th>Yes</th>
<th>No</th>
<th>Time of command</th>
<th>Time of “click”</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. used key command</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. selected File&gt;Save from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>c. optional: closed file with key command</td>
<td>yes</td>
<td></td>
<td>0:01:45:02</td>
<td></td>
</tr>
<tr>
<td>d. optional: selected File&gt;Close from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e. optional: selected File&gt;Close from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>f. optional: closed Photoshop with key command</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>g. optional: selected File&gt;Exit from Photoshop menu to close program</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

7. Click on “stop capture” | Yes | No | Ending Time |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>0:01:55:21</td>
</tr>
</tbody>
</table>
Appendix M

Task Scoring Rubric
Summary of Scores:

File Name: ________________

DV 1. Time to Complete: ____________
*Total minutes and seconds displayed at the last frame of the video capture

DV 2. Correct Responses: ____________
*Total points column 3 of rubric

DV 3. Errors: ____________________
*Total error clicks column 2 of rubric

DV 4. Can Do: ____________________
*Did the student ultimately complete the adjustment?

☐ Yes ☐ No
Task One Scoring Rubric  
Evaluator:  
Condition:  
Participant Number  

Correct Responses:  
*Use the following rubric to calculate the correct responses. (total points column 3)  
Errors:  
*(total of number of error clicks from column 2)  

<table>
<thead>
<tr>
<th>Response</th>
<th>Completed</th>
<th>Check No or Yes</th>
<th>Points</th>
<th>Time Stamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open Photoshop</td>
<td>[ ] Yes</td>
<td>[ ] No</td>
<td>______</td>
<td>Time of “click”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0=no</td>
<td>___ : ___ : ___</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1=yes</td>
<td>Time of “click”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>___ : ___ : ___</td>
</tr>
<tr>
<td>a. clicked on Photoshop</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>icon in Dock to open</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image file and chose “open</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>with Photoshop” from list.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1 If no: how many</td>
<td>number of error clicks?____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>error clicks before</td>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>resuming at step 1?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Open Task 1,Test</td>
<td>[ ] Yes</td>
<td>[ ] No</td>
<td>______</td>
<td>Time of “click”</td>
</tr>
<tr>
<td>Image</td>
<td></td>
<td></td>
<td>0=no</td>
<td>___ : ___ : ___</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1=yes</td>
<td>(see time above)</td>
</tr>
<tr>
<td>a. from Photoshop:</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>clicked on “OPEN FILE”</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>and navigated to Task 1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Test image</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Image file and chose “open</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>with Photoshop from list</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>in Step 1.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1 If no: how many</td>
<td>number of error clicks?____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>error clicks before</td>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>resuming at step 2?</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task One Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------</td>
<td>-----------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Evaluator: ____________</td>
<td>___________</td>
<td>__________</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Yes</th>
<th>No</th>
<th>Time of “click”</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>Select Image&gt; Adjustment&gt; Autocolor</td>
<td>☐ Yes</td>
<td>☐ No</td>
<td>__________</td>
</tr>
<tr>
<td></td>
<td>number of error clicks? _____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td>Select Image&gt; Adjustment&gt; Shadow / Highlight</td>
<td>☐ Yes</td>
<td>☐ No</td>
<td>__________</td>
</tr>
<tr>
<td></td>
<td>number of error clicks? _____</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td>Set slider values</td>
<td>☐ Yes</td>
<td>☐ No</td>
<td>__________</td>
</tr>
<tr>
<td></td>
<td>a. highlight final value:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. shadow final value:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Which slider was adjusted first?</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. highlight</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. shadow</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. no</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. no, clicked to check it</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.1</td>
<td>Clicked OK to accept adjustment?</td>
<td>__________</td>
<td>Time of “click”</td>
<td>: : : : :</td>
</tr>
<tr>
<td></td>
<td>a. yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. no</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.2</td>
<td>number of error clicks? _____</td>
<td>NOTE:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>__________</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task One Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------</td>
<td>------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Evaluator:</strong>__________</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Condition:</strong>__________</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Save file</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>□ Yes</td>
<td>□ No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.1</td>
<td>□ a. used key command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>□ b. selected File&gt;Save from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>□ c. optional: closed file with key command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>□ d. optional: selected File&gt;Close from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>□ e. optional: selected File&gt;Close from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>□ f. optional: closed Photoshop with key command</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>□ g. optional: selected File&gt;Exit from Photoshop menu to close program</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7.2</td>
<td>If no: how many error clicks before continuing to step 9?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>number of error clicks?_____</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>Click on &quot;stop capture&quot;</td>
<td>□ Yes</td>
<td>□ No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ending Time</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| 8.1 | If no: how many error clicks before clicking on stop capture? |   |   |   |   |   |   |   |   |   |
|     | number of error clicks?_____ |   |   |   |   |   |   |   |   |   |
|     | NOTE: |   |   |   |   |   |   |   |   |   |
Task Two Scoring Rubric
Evaluator:______________   Participant Number ______
Condition:______________

Summary of Scores:

File Name: ________________

DV 1. Time to Complete: ____________
*Total minutes and seconds displayed at the last frame of the video capture

DV 2. Correct Responses: ____________
*Total points column 3 of rubric

DV 3. Errors: ________________
*Total error clicks column 2 of rubric

DV 4. Can Do: ________________
*Did the student ultimately complete the adjustment?

☐ Yes  ☐ No
## Task Two Scoring Rubric

**Evaluator:**

**Condition:**

**Participant Number:**

### Correct Responses:

*Use the following rubric to calculate the correct responses. (total points column 3)

### Errors:

*(total of number of error clicks from column 2)*

<table>
<thead>
<tr>
<th>Response</th>
<th>Completed Check No or Yes</th>
<th>Points 0=no... 1=yes</th>
<th>Time Stamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open Photoshop</td>
<td>□ Yes □ No</td>
<td></td>
<td>Time of “click”</td>
</tr>
<tr>
<td>a. clicked on Photoshop icon in Dock to open Program.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test Image file and chose “open with Photoshop” from list.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1 If no: how many error clicks before resuming at step 1?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Open Task 2, Test Image</td>
<td>□ Yes □ No</td>
<td></td>
<td>Time of “click”</td>
</tr>
<tr>
<td>a. from Photoshop: clicked on “OPEN FILE” and navigated to Task 1-Test image</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test Image file and chose “open with Photoshop from list in Step 1.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1 If no: how many error clicks before resuming at step 2?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Two Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>--------------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>Evaluator:_____________</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>3. Select Crop Tool</td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Time of “click”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. If no: how many error clicks before resuming at step 3?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NOTE:</td>
</tr>
<tr>
<td>4.1 If no: how many error clicks before resuming at step 4?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NOTE:</td>
</tr>
<tr>
<td>5. Rotate the marquee from the handle to match the angle of the image</td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Time of “click”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.1 If no: how many error clicks before resuming at step 5?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NOTE:</td>
</tr>
<tr>
<td>6. Match size of image by dragging the marquee in from all sides</td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Time of completed all sides</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6.1 If no: how many error clicks before resuming at step 6?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NOTE:</td>
</tr>
<tr>
<td>7. Press Enter to Crop the Image</td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Time of command</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Two Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td><strong>Evaluator:</strong>__________</td>
<td></td>
<td>__________</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>7.1 If no: how many error clicks before continuing to step 7?</th>
<th>number of error clicks?____</th>
<th>NOTE:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8. Save file</td>
<td>Q Yes</td>
<td>Q No</td>
<td></td>
</tr>
<tr>
<td>8.1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. used key command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. selected File&gt;Save from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>c. optional: closed file with key command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>d. optional: selected File&gt;Close from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>e. optional: selected File&gt;Close from Photoshop menu</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>f. optional: closed Photoshop with key command</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>g. optional: selected File&gt;Exit from Photoshop menu to close program</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of command <strong>:</strong>:__</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of “click” <strong>:</strong>:__</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of command <strong>:</strong>:__</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of “click” <strong>:</strong>:__</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of command <strong>:</strong>:__</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time of “click” <strong>:</strong>:__</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8.2 If no: how many error clicks before clicking on stop capture?</th>
<th>number of error clicks?____</th>
<th>NOTE:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>9. Click on “stop capture”</td>
<td>Q Yes</td>
<td>Q No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ending Time <strong>:</strong>:<strong>:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Task Three Scoring Rubric
Evaluator: ____________ | Participant Number _____
Condition: ______________

Summary of Scores:

File Name: ________________

DV 1. Time to Complete: __________
* Total minutes and seconds displayed at the last frame of the video capture

DV 2. Correct Responses: __________
* Total points column 3 of rubric

DV 3. Errors: ________________
* Total error clicks column 2 of rubric

DV 4. Can Do: ________________
* Did the student ultimately complete the adjustment?

☐ Yes ☐ No
## Task Three Scoring Rubric

**Evaluator:**

**Participant Number:**

**Condition:**

### Correct Responses:

*Use the following rubric to calculate the correct responses. (total points column 3)*

### Errors:

*(total of number of error clicks from column 2)*

<table>
<thead>
<tr>
<th>Response</th>
<th>Completed Check Yes or No</th>
<th>Points 0=no, 1=yes</th>
<th>Time Stamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>10. Open Photoshop</td>
<td>□ Yes □ No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. clicked on Photoshop icon in Dock to open Program.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test Image file and chose “open with Photoshop” from list.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10.1 If no: how many error clicks before resuming at step 1?</td>
<td></td>
<td>number of error clicks?</td>
<td>ARRANGE</td>
</tr>
<tr>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11. Open Task 3_Test Image</td>
<td>□ Yes □ No</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. from Photoshop: clicked on “OPEN FILE” and navigated to Task 1-Test Image</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>b. RT clicked on Test Image file and chose “open with Photoshop from list in Step 1.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. Choose Window &gt; Histogram in Navigator Pallet group</td>
<td>□ Yes □ No</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time of “click”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>: : : :</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time of “click”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>: : : :</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>(see time above)</td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
<td>Option</td>
<td>Option</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>12.1</td>
<td>If no: how many error clicks before resuming at step 3?</td>
<td>number of error clicks?</td>
<td>Yes</td>
</tr>
<tr>
<td>13</td>
<td>Click arrow in upper right corner to display palette menu</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>13.1</td>
<td>If no: how many error clicks before resuming at step 4?</td>
<td>number of error clicks?</td>
<td>Yes</td>
</tr>
<tr>
<td>14</td>
<td>Choose Expanded View</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>14.1</td>
<td>If no: how many error clicks before resuming at step 5?</td>
<td>number of error clicks?</td>
<td>Yes</td>
</tr>
<tr>
<td>15</td>
<td>Choose Image &gt; Adjustments &gt; Levels to open Levels dialog box</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>15.1</td>
<td>If no: how many error clicks before resuming at step 6?</td>
<td>number of error clicks?</td>
<td>Yes</td>
</tr>
<tr>
<td>16</td>
<td>Set slider values</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>16.1</td>
<td>a. drag the left triangle to the right to the point where the histogram indicates that the darkest colors begin: final value:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. drag the right triangle to the left to the point</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task</td>
<td>Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition</td>
</tr>
<tr>
<td>------</td>
<td>---------------</td>
<td>--------------------</td>
<td>-----------</td>
</tr>
<tr>
<td></td>
<td>Evaluator:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>where the histogram indicates that the lightest colors begin: final value:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. drag the middle triangle a short distance to the left to lighten the midtones: final value:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Which slider was adjusted first?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. dark</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. light</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. midtones</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Which slider was adjusted second?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. dark</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. light</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. midtones</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>17.</th>
<th>Is Preview checked in the dialog box?</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. no</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. no, clicked to check it</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time of “click”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17.1</td>
<td>Clicked OK to accept adjustment?</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. no</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time of “click”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18.</td>
<td>Save file</td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. Yes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. No</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time of command</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18.1</td>
<td>a. used key command</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time of command</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. selected File&gt;Save from Photoshop menu</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time of “click”</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. optional: closed file with key command</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Time of command</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Task Three Scoring Rubric | Participant Number _____ | Condition: ______ 
|--------------------------|--------------------------|------------------|
| Evaluator: ________ | d. optional: selected File>Close from Photoshop menu | Time of “click” 
| | e. optional: selected File>Close from Photoshop menu | Time of “click” 
| | f. optional: closed Photoshop with key command | Time of command 
| | g. optional: selected File>Exit from Photoshop menu to close program | Time of “click” 

| 18.2 If no: how many error clicks before clicking on stop capture? | number of error clicks? _____ | 
| | NOTE: | 

| 19. Click on “stop capture” | Yes | No | Ending Time |
| | | | ______ |

| | | |
| | | |
| | | |
| | | |
Task Four Scoring Rubric

Evaluator: 

Participant Number 

Condition: 

Summary of Scores:

File Name: 

DV 1. Time to Complete: 

*Total minutes and seconds displayed at the last frame of the video capture

DV 2. Correct Responses: 

*Total points column 3 of rubric

DV 3. Errors: 

*Total error clicks column 2 of rubric

DV 4. Can Do: 

*Did the student ultimately complete the adjustment?

[ ] Yes  [ ] No
**Task Four Scoring Rubric**

**Evaluator:**

**Participant Number ____**

**Condition:**

---

### Correct Responses:

*Use the following rubric to calculate the correct responses. (total points column 3)*

### Errors:

*(total of number of error clicks from column 2)*

<table>
<thead>
<tr>
<th>Response</th>
<th>Completed Check Yes or No</th>
<th>Points (0=no... 1=yes)</th>
<th>Time Stamp</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open Photoshop</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. clicked on Photoshop icon in Dock to open Program.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. RT clicked on Test Image file and chose “open with Photoshop” from list.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.1 If no: how many error clicks before resuming at step 1?</td>
<td>number of error clicks?____</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Open Task 4, Test Image</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>a. from Photoshop: clicked on “OPEN FILE” and navigated to Task 1- Test image</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. RT clicked on Test Image file and chose “open with Photoshop from list in Step 1.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.1 If no: how many error clicks before resuming at step 2?</td>
<td>number of error clicks?____</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NOTE:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Four Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td><strong>Evaluator:</strong></td>
<td></td>
<td>___________________________</td>
<td></td>
</tr>
<tr>
<td><strong>3.</strong> Select the Zoom tool in the toolbox</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>3.1</strong> If no: how many error clicks before resuming at step 3?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>4.</strong> Click in the flaw to enlarge that area to 200%</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>4.1</strong> If no: how many error clicks before resuming at step 4?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>5.</strong> Select the Healing Brush tool hidden under the Spot Healing Brush tool</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>5.1</strong> If no: how many error clicks before resuming at step 5?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>6.</strong> In the tool options bar open the Brush Preset pop-up palette</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>6.1</strong> If no: how many error clicks before resuming at step 6?</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>7.</strong> Adjust the Diameter to an appropriate size for the repair</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>☐ Yes</td>
<td>☐ No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>7.1</strong> If no: how many</td>
<td>number of error clicks?</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Four Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Evaluator:**

<table>
<thead>
<tr>
<th>Error clicks before resuming at step 7?</th>
<th>NOTE:</th>
<th></th>
<th></th>
</tr>
</thead>
</table>

8. Close the Pop-up Palette

- Yes
- No

- Time of “click”

8.1 If no: how many error clicks before resuming at step 8?

- Number of error clicks?
- NOTE:

9. Make sure that the other settings in the tool options bar are set to the default values: NORMAL MODE.

- Yes
- No

9.1 If no: how many error clicks before resuming at step 9?

- Number of error clicks?
- NOTE:

10. SAMPLED in the SOURCE option

- Yes
- No

10.1 If no: how many error clicks before resuming at step 10?

- Number of error clicks?
- NOTE:

11. DESELECT the SAMPLE ALIGNED check box

- Yes
- No

- Time settings are completed

11.1 If no: how many error clicks before resuming at step 11?

- Number of error clicks?
- NOTE:
<table>
<thead>
<tr>
<th>Task Four Scoring Rubric</th>
<th>Participant Number</th>
<th>Condition</th>
</tr>
</thead>
</table>

**Evaluator:**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Options</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>12.</td>
<td>Hold down the Option key and click near the flaw in the image to sample an unflawed area</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12.1</td>
<td>If no: how many error clicks before resuming at step 12?</td>
<td>number of error clicks?</td>
<td>NOTE:</td>
</tr>
<tr>
<td>13.</td>
<td>Release the ALT key</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>13.1</td>
<td>If no: how many error clicks before resuming at step 13?</td>
<td>number of error clicks?</td>
<td>NOTE:</td>
</tr>
<tr>
<td>14.</td>
<td>Apply the Healing Brush to cover the flaw using short Strokes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14.1</td>
<td>If no: how many error clicks before resuming at step 13?</td>
<td>number of error clicks?</td>
<td>NOTE:</td>
</tr>
<tr>
<td>15.</td>
<td>Zoom out to 100% to check work</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15.1</td>
<td>If no: how many error clicks before resuming at step 15?</td>
<td>number of error clicks?</td>
<td>NOTE:</td>
</tr>
<tr>
<td>16.</td>
<td>Save file</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>16.1</td>
<td>a. used key command</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. selected File&gt;Save from Photoshop menu</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time of command</td>
<td>: : : : :</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Time of &quot;click&quot;</td>
<td>: : : : :</td>
</tr>
<tr>
<td>Task Four Scoring Rubric</td>
<td>Participant Number</td>
<td>Condition</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------</td>
<td>-----------</td>
<td></td>
</tr>
<tr>
<td>Evaluator:</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>q. optional: closed file with key command</td>
<td>Time of command</td>
<td></td>
<td></td>
</tr>
<tr>
<td>r. optional: selected File-&gt;Close from Photoshop menu</td>
<td>Time of “click”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>s. optional: selected File-&gt;Close from Photoshop menu</td>
<td>Time of “click”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>t. optional: closed Photoshop with key command</td>
<td>Time of command</td>
<td></td>
<td></td>
</tr>
<tr>
<td>u. optional: selected File-&gt;Exit from Photoshop menu to close program</td>
<td>Time of “click”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

16.2 If no: how many error clicks before clicking on stop capture? number of error clicks? NOTE:

17. Click on “stop capture” | Yes | No | Ending Time |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix N

Prior Knowledge Pretest Answer Key
PRETEST-Booklet-KEY | 10 Minutes

PRETEST

Participant Number: ________________

Score: ________________
PRETEST OF PRIOR PHOTOSHOP KNOWLEDGE: Key

Instructions:

Please attempt ALL questions. Each question includes several optional statements or answers; you should select the one most appropriate answer. Circle the option letter of your selected answer on the question paper.

1. Which drop-down menu contains the Shadows and Highlights adjustment?
   a. File
   b. Edit
   c. Image
   d. Layer
   e. Select
   f. Filter
   g. Analysis
   h. View
   i. Window

2. What tool do you use to straighten an image?
   a. Move
   b. Rectangular Marquee
   c. Magic Wand
   d. Crop
   e. Path Selection
   f. Rectangle
   g. Slice

3. What is the value of the Shadows adjustment point in the following histogram?
   a. 0
   b. 1.0
   c. 255

![Histogram Image]
4. Please circle the icon that represents the crop tool.

5. Please circle the location of the healing brush.

6. What information can you deduce from this histogram?
   a. The image is too light
   b. The image is too dark.
   c. The image levels have been adjusted.
   d. The image levels need to be adjusted.

7. Which tool would you use to retouch this image photo?
   a. Clone Stamp tool
   b. Spot Healing Brush
   c. Healing Brush
   d. History Brush
8. What can you do with the Crop tool?
   a. Add space around an image
   b. Straighten an image
   c. None of the above
   d. Both of the above

9. By default, how many items are recorded in the History pallet?
   a. 20
   b. 40
   c. 100
   d. Unlimited

10. What tool do you use to remove a color cast from an image?
    a. Saturation
    b. Auto Levels
    c. Hue and Saturation
    d. Auto Color Correction
Appendix O

Prior Knowledge Pretest Validity Instrument
# PRIOR PHOTOSHOP KNOWLEDGE

**Instructions:**

Please score each of the following questions. Each question measures a key concept or knowledge point. Circle the number of your selected answer on the question paper.

The rating scale is: 1 = *Does not measure the concept* to 5 = *Measures the concept well*

<table>
<thead>
<tr>
<th>Concept</th>
<th>Test Item</th>
<th>Likert Score</th>
</tr>
</thead>
</table>
| Shadow and Adjustment Tool Location | 1. Which drop-down menu contains the Shadows and Highlights adjustment?  
   a. File  
   b. Edit  
   c. Image  
   d. Layer  
   e. Select  
   f. Filter  
   g. Analysis  
   h. View  
   i. Window | 1 2 3 4 5 |
| Crop Tool | 2. What tool do you use to straighten an image?  
   a. Move  
   b. Rectangular Marquee  
   c. Magic Wand  
   d. Crop  
   e. Path Selection  
   f. Rectangle  
   g. Slice | 1 2 3 4 5 |
### PRETEST-Content Validity Instrument

<table>
<thead>
<tr>
<th>Prior knowledge of levels adjustment dialog box</th>
<th>3. What is the value of the Shadows adjustment point in the following histogram?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. 0</td>
</tr>
<tr>
<td></td>
<td>b. 1.0</td>
</tr>
<tr>
<td></td>
<td>c. 255</td>
</tr>
</tbody>
</table>

![Image of Histogram with Level Values](image1.png)

<table>
<thead>
<tr>
<th>Prior knowledge of the crop tool</th>
<th>4. Please circle the icon that represents the crop tool.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><img src="image2.png" alt="Crop Tool Icons" /></td>
</tr>
</tbody>
</table>

![Image of Crop Tool Icons](image2.png)

| 1 | 2 | 3 | 4 | 5 |
## PRETEST-Content Validity Instrument

<table>
<thead>
<tr>
<th>Prior knowledge of the healing brush</th>
<th>5. Please circle the location of the healing brush.</th>
<th>1 2 3 4 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Image of healing brush options]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prior knowledge of histogram interpretation</th>
<th>6. What information can you deduce from this histogram?</th>
<th>1 2 3 4 5</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Image of histogram window]</td>
<td>a. The image is too light</td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. The image is too dark</td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. The image levels have been adjusted.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. The image levels need to be adjusted</td>
<td></td>
</tr>
</tbody>
</table>

[Image of histogram window with analysis options]
## PRETEST-Content Validity Instrument

<table>
<thead>
<tr>
<th>Prior knowledge of appropriate retouching tools</th>
<th>7. Which tool would you use to retouch this torn photo?</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. Clone Stamp tool</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Spot Healing Brush</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Healing Brush</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. History Brush</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prior knowledge of advanced uses for the crop tool</th>
<th>8. What can you do with the Crop tool?</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. Add space around an image</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Straighten an image</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. None of the above</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>d. Both of the above</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prior knowledge of advanced characteristics of the history pallet</th>
<th>9. By default, how many items are recorded in the History palette?</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. 20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. 40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Unlimited</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Prior knowledge of color correction</th>
<th>10. What tool do you use to remove a color cast from an image?</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>a. Saturation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>b. Auto Levels</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>c. Hue and Saturation</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Auto Color Correction</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>